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What's new in Sequoia 17 ?

The most important innovations in  at a glance:Sequoia 17

Optimized export workflow with a new export window and an export list to process several formats or projects at once.
Reworked crossfade editor for more consistent window handling
Take Lanes: Comping, i.e. combining sections from different recording takes, no longer takes place in a separate Take Composer
window, but directly in the project below the track in the new Take Lanes
Marker track: Markers are displayed  in their own track. The height of the track can be freely adjusted so that long marker names
are no longer cut off by following markers. The markers can now also be colored, the Marker track head contains buttons for
creating, coloring, and locking markers.
AudioWarp: Warp markers can now be added to audio objects, to correct irregularities in a recording, or to change the audio
rhythmically.
Many :improvements to and an  for working in the project window improved GUI design

New, meaningful mouse pointers for the editing areas in the track
Numerically adjustable volume directly at the object
Optimized display of notes in MIDI objects
Improved default settings for many display options
Color button in the object editor sets the object background color.

Dockable mixer and plug-in browser
Plug-ins

External hardware effects available as plug-in
Support for  and extended MIDI routing MIDI plug-ins
VST3 plug-in compatibility improvements
Softube Console 1 Support
ARA plug-ins can now be inserted as track effects

Help and manual have been completely revised and updated

New in 17.1

FX I/O Matrix (Enterprise version / maintenance contract only): Opened from the "Plug-in" menu of a VST Plugin dialog to route
track audio channels into plug-in input channels and plug-in output channels to track audio channels.
Additional waveform scaling option for scaling with object fades and volume curves only, without track volume curves.
More GUI improvements:

Use  key while dragging a window to avoid dockingCtrl
The horizontal mixer size is now stored globally, i.e the width of the mixer window is now maintained when tracks are added
or the project is switched.
Lock groups are now displayed as colored spot on lock buttons
New menu command to select the active track only (default shortcut Shift+Alt+Enter).
New commands in automation menu to show only Vol/Pan/AUX/EQ/Plug-in automation lanes

Comping with take lanes improved: Audio and MIDI takes can be switched together in take lanes. Obsolete takes that occur when
working in the take lanes can be removed in the dialog "Project status".
More ARA plug-ins supported: RipX DAW can be used, compatibility with the Synchro Arts VocAlign and Synchro Arts Revoice
plug-ins has been improved.

New in 17.2

Markers and range markers:
Marker manager: The marker manager can also show audio markers and warp markers of a selected object. You can have
multiple marker managers open that can have different settings (window positions, columns etc.) which are individually
saved.
Range markers and range marker track: Saved ranges are shown as range markers in a separate track similar to the
marker track. Range markers are shown in the marker manager like project markers, hence the range manager was
removed. There is a unified keyboard shortcut for saving markers and range markers with shift + number key. With marker
lines, markers and range markers can be extended across all tracks.

Improved metering: There's a new option to switch track peak meter to show the hardware input level automatically when the track
is armed for recording. Also any track input is available as input source for a visualization window.
Export Improvements: 

Improved single track export: When exporting the project into individual tracks, there's a new option to include the
 . This means that if tracks are routed to submix buses that contain their own effects orcontent of AUX or Submix busses

if tracks send to AUX buses, the influence of these buses is also included in the exported files of the individual tracks.
Export selected range markers: A new time selection option "Selected range markers" was added. This allows you to
export each selected stored range in a separate file.

Recently loaded or saved files: Now up to 16 entries of the last used files are available in a dedicated File menu sub menu and in
the start dialog. You can access these quickly with keyboard shortcut Ctrl + Backspace.
FX I/O Matrix (Enterprise version / maintenance contract only): The FX I/O Matrix now also allows existing sidechain inputs to be
routed to plug-in inputs.



New in 17.3

Dolby Atmos / ADM: 
ADM and Dolby Atmos metadata editing & import: Using the new ADM Editor, metadata can be created from scratch,
modified, or adapted from existing projects. Sequoia now allows importing ADM and Dolby Atmos metadata from ADM/BWF
files.
Monitoring and renderer output options: Monitoring playback is available through the ADM or Dolby Atmos renderer.
When using the Dolby Atmos renderer, stereo or binaural output can be accessed separately from the monitoring section.
Additionally, a loudness display provides real-time level information, and a trim control allows scaling all renderer inputs to
achieve the desired loudness. 
ADM file export and Dolby Atmos loudness management: Projects can be exported as BWF files with ADM metadata for
use with encoding tools or distribution services  Users can choose to export either the entire project or a selected range..
Additionally, when exporting for Dolby Atmos, a separate loudness report can be generated as a text file for precise level
management.
Additional resources and Dolby Atmos template: For more details, press F1 in the ADM Editor. Alternatively, try the new
Dolby Atmos template (Dolby Atmos 7.1.4.VIP) to get started with Dolby Atmos.

Surround improvments
Surround presets: The surround presets have been restructured and renamed for better organization, including new and
updated Dolby Surround setups and additional ITU surround presets like Sound System D (5.1.4). Additionally, a quick
access feature now enables faster selection of frequently used presets.
Surround Aux sends: AUX send panning can now be displayed in the track panning dialog. Enable this via "Show AUX
Sends" in the ‘+’ button menu. By default, surround AUX sends follow the main surround panner in linked mode, which can
now be disabled for independent panning. Stereo AUX sends can toggle between linked mode and "Follow track pan"
behavior.

New program option – invert docking behavior: A new setting allows you to invert the docking behavior of windows while
dragging. By default, docking is enabled and holding Ctrl disables it. When the option is switched off, docking is disabled by default
and can only be enabled by holding Ctrl.
Multichannel support for Algorithmix Renovator (Enterprise version / maintenance contract only): If Sequoia detects a Renovator
installation, you can access the command directly by selecting one or more objects, opening the context menu, and navigating to
Effects (Offline) > Restoration > Spectral Editor Renovator. The selected tracks will be sent to Renovator and the tool will open. You
can now play back your edits directly in Renovator while the project continues to run simultaneously, allowing you to compare your
adjustments in context

New features and changes in detail
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Sequoia only

Enterprise version only
[SEQ-8978] [SEQ-9159] Multichannel support for Renovator

Including realtime preview in arranger context
Dolby Atmos / ADM

Import ADM or Dolby Atmos meta data from ADM / BWF files
Edit or create metadata either from scratch or based on your existing projects

Use object based 3D surround panning
Mono tracks default position is front center
Stereo tracks per default use Y-symmetry, but can be switched to angle offset behaviour

Preview with ADM or Dolby Atmos renderer
Dolby Atmos renderer only

Access stereo or binaural output from Monitoring section
Display loudness information
Gain control to scale all renderer inputs

Export into an ADM file, which can be used with Dolby Atmos encoding tools or send to distribution services
Optionally calculate and write loudness values into separate text file

Uses ITU-1771 loudness settings with adapted target value of -18 LUFS
Export whole project or selected range only

For more detailed info in online help press F1 in ADM editor
There are 3 Dolby Atmos templates (using a )fixed sample rate of 48kHz

Dolby Atmos/Dolby Atmos 7.1.4.VIP (additional info available in the info manager)
Music Mixing Dolby Atmos 7.1.4
Post Production Dolby Atmos 7.1.4

Beside the original "Rush hour" demo project, there are now 2 additional versions prepared for Dolby Atmos
Surround

[SEQ-8899] [SEQ-9077] Restructured and renamed surround presets
[SEQ-9077] New + updated Dolby surround setups
[SEQ-8843] Added several ITU surround setup presets (e.g. Sound System D (5.1.4))

[SEQ-9030] Quick access to recently used surround presets
[SEQ-8859] Scroll mixer if expanding surround sub-channels
[SEQ-8859] Scroll arranger to new track when adding surround busses or masters



[SEQ-7575] Changed display of selected tracks in mixer - now also working for surround tracks
[SEQ-8373] [SEQ-9219] Automation for internal surround FX

EQ116: all channels except LFE are grouped by default
This first channel group can now be automated similar to EQ automation on non-surround tracks

[SEQ-9098] Surround track FX settings can be loaded again if channel count matches
[SEQ-9239] Right channel position is now also visible in mixer and track editor
[SEQ-7651] Optionally show AUX send panning in track panning dialog

Select "Show AUX Sends" in drop down menu of '+'-Button
Default surround AUX Sends are using "linked" mode and follow main surround panner

Linked mode can be switched off now for independent AUX panning
Stereo AUXes link switch toggles the existing "Follow track pan" behaviour

[SEQ-9240] Mute / solo fixes / improvements
Allow menu commands for solo / solo exclusive / solo safe for surround busses
Automatic solo safe for AUXes didn't work correctly, if AUXes were feeding different submix busses than original
tracks
Solo or mute buttons of surrund busses with active channel link now always switches track solo /mute

Channel solo / mute can only be switched with pressed Alt key or inactive channel link
This is now indicated by a colored frame arround the solo or mute button

Bug fixes
[SEQ-9038] Internal Surround Plug-Ins were limited to 12 channels
[SEQ-8821] Fix some inconsistencies with default values of surround curves
[SEQ-9038] [SEQ-9028] [SEQ-8900] Stability issues when changing surround setups
[SEQ-9116] No automatic renaming of manually named busses after changing surround format
[SEQ-9149] Mixer: Missing surround panner displays after copy & paste of tracks
[SEQ-9141] New tracks in surround projects were routed to the inactive stereo master instead the surround master
by default
[SEQ-9229] Default surround pan presets handling did only work for primary track output
[SEQ-8373] EQ access from track editor didn't work on surround busses
[SEQ-9242] Volume, Internal FX, and Mute/Solo didn't work with legacy "Stereo" surround preset

Import / Export
[SEQ-9181] Export dialog: more precise wording for "Include ... effects" options to show that volume, gain, and pan are
included
[SEQ-8493] Export naming template - New place holder for EAN
[SEQ-9052] Rounding issues with tempo markers in MIDI files

Improved accuracy when exporting tempo markers into MIDI files
ini setting  MidiImportRoundBpmDigits=2 for further improved accuracy when re-importing MIDI file[Factors]

[SEQ-8828] Extend warning for files outside project folder and collect files to clip store
Bug fixes

[SEQ-8240] Standard INZ container updated with default export presets
[SEQ-9137] Relinking of renamed multichannel files didn't work correctly
[SEQ-9157] Some problems with project templates if they had dots in file name or were stored in sub folders of
"Templates"
[SEQ-9201] Multiformat Export: when exporting 16 Bit Wave + MP3 wave was exported as 32 Bit
[SEQ-9167] Multiformat Export: issues with "Automatic" channels setting
[SEQ-9188] AAC export: error message during export with some AAC settings (incompatible settings can't be
selected anymore)
[SEQ-9181] Some tab order optimizations
[SEQ-9232] Loading projects from start screen could fail under special circumstances

Playback / Record
[SEQ-9004] New take naming template "(take name)_(track number)_(track name)"
Bugfixes

[SEQ-8711] Missing takes after reordering or adding tracks (only works reliably for newly recorded takes, not for
)older projects

[SEQ-8711] Multi track take handling might not work if lanes are opened automatically after loading a project
[SEQ-8711] Issues when transfering takes to another project with copy&paste
[SEQ-9199] Distortion of internal track recording when reaching levels of exactly 0 dB (e.g. as output from some
limiter plug-ins)

Folder tracks
[SEQ-8901] Automation lanes are visible in folder tracks with reference track or folder track as VCA master
[SEQ-8859] Scroll arranger to new track when adding folder tracks

Plug-ins
[SEQ-8845] Plug-in browser: Allow to add VST3 plug-in without ARA extension via menu or Ctrl + Add
Bugfixes

[SEQ-9070] External FX: Peakmeter not active when opening dialog while playback or while monitoring in stopped
state
[SEQ-9195] Issues with resizable plug-in GUIs
[SEQ-9169] Some finetuning for automatic FX closing and re-opening when switching to another project (e.g. for
External FX dialog)
[SEQ-9172] Gap in audio output of VST plug-ins with latency after renaming or coloring tracks

GUI
[SEQ-8897] New program option for inverting docking behaviour of windows while dragging

Active (Default): allow docking, disable docking with pressed Ctrl key
Switched off: allow docking only with pressed Ctrl key

[SEQ-8575] Further fine-tuning of display on HDPI/4k monitors when using application scaling, e.g. for monitoring section
(still under construction)

[SEQ-9186] Crossfade editor option for legacy GUI of Sequoia 16 and older versions
[SEQ-8865] Snap to object end with active Slip left modes



Bugfixes
[SEQ-9143] Blackfade insert was partially placed before in-point
[SEQ-8894] Possible issues when adding Crossfade Editor shortcuts
[SEQ-9138] Possibly delayed first playstart after loading interleaved or ADM files
[SEQ-9250] Issues with storing loudness measurement parameters
Markers

[SEQ-9183] Audio marker to project marker: created multiple markers on same position in some cases
Mixer / Track / Object Editor

[SEQ-7575] Improve input section and solo button alignment in mixer
[SEQ-8776] Mixer faders were too large after restoring main section in docked mixer
[SEQ-8776] Optimized mixer fader length after restoring main section in docked mixer

Automation
[SEQ-9133] Link curves to objects: Improved behaviour when moving objects to different track 
[SEQ-9133] Curve point exactly at project start was not drawn
[SEQ-9134] Link curves to objects: Transfer of plugin automation didn't work for surround tracks

MIDI / VSTi
 Issues with MIDI files in recent file list[SEQ-9052]

 (a VIP is always created now) For some cases, MIDI files could be loaded without existing VIP[SEQ-9052]
[SEQ-9215] Possible crash in VSTi manager when assigning MIDI channel after deleting tracks

[SEQ-9197]  Crash fixes (e.g for possible crashes at first playback start and after increasing ASIO buffer size)[SEQ-9151]
[SEQ-9190] Empty quantization display for full bars with other than 4/4 measure
[SEQ-9131] Previous loop range was not visible anymore after using cut mouse mode
General

[SEQ-9144] Some tooltip fixes
[SEQ-8564] EN: Missing word separation in record dialog (e.g. Format options)
[SEQ-8564] DE: Untranslated "Warning" caption in some dialogs
[SEQ-9187] Unreadable ... in DE dialogs
[SEQ-9205] Menu display issues in with extended beta UTF-8 support of Windows
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[SEQ-9003] Warning for audio files outside project folder updated
Warning now appears for every save command, not only once
"Details..." opens "Collect project files" dialog
Bugfixes

Collect project files didn't show files from project folder root
Bug fixes

[SEQ-8990] Missing object editor update when switching between projects
[SEQ-9165] Track editor : Wrong display of hover state for scroll up/down buttons
[SEQ-9073] Some GUI fixes (e.g. wrong audio input color in track editor canis skin)
[SEQ-9056] Keep folder hierarchy when exchanging multiple tracks
[SEQ-9173] CD Arrangement mode: wrong behavior when moving last track marker
[SEQ-9110] Possible crashes after leaving program unattended for long time
Import / Export

[SEQ-9053] Digas DBM: Drag&Drop Audio to a project did not create objects
[SEQ-] Export option "Include busses" didn't work correctly for busses, which were fed by other busses9155
[SEQ-] Export Dialog: Option "Embed markers into audio" > "CD markers only" did not work for surround
export9045
[SEQ-9031] Wrong formatted encoding string in iXML chunk
[SEQ-8883] Possible garbage data with MPEG export
[SEQ-9117] AAF Import: possible wrong object positions in some special cases

Plug-ins
[SEQ-9114] Plug-ins on mono tracks were loaded with stereo configuration (and set to mono only with first playback
start)
[SEQ-8979] Fixed channel mapping issues for VST2 plug-ins with more than 8 output channels
[SEQ-9070] External FX: Peakmeter not active when opening dialog while playback
[SEQ-9017] Sound Particles Plug-ins crashes with activated HWC support
[SEQ-5971] Issues with plug-ins replaced by unfreeze
[SEQ-9135] Plug-in latency compensation didn't work for offline FX

Automation
[SEQ-9063] Crash while moving objects to another track in 'Link curves to objects' object mode
[SEQ-8696] Changing automation point values via 'change object volume' shortcuts: object automation is now
handled like track automation (values over 0dB allowed)
[SEQ-9046] Link curves or markers to objects didn't work with "Object to original time position"

Markers
[SEQ-7999] Issue with restoring marker track height after shrinking and increasing project window height
[SEQ-9059] Creating a new range marker could delete an existing marker at the same position
[SEQ-9033] Marker Manager: color row sorting didn't work
[SEQ-7404] Marker manager : Dysfunctional menu item 'edit warp marker position' hidden
[SEQ-9064] Added some missing tooltips for marker track buttons
[SEQ-9064] Drawing issues with frame below marker track

MIDI
[SEQ-9001] MIDI file import could crash for files with many tracks
[SEQ-9071] Global option for switching off tempo changes for MIDI objects was ignored
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Enterprise version / maintenance contract only: 
[SEQ-8667] FX I/O Matrix for plug-ins: Side chain handling

[SEQ-6755] Preset handling for loudness normalization
Remember last used preset
Mark changes with *
"Default" and "Previous settings" presets added

[SEQ-9005] Some macros for moving range start or end were named wrong, now they use an additional dot, e.g. rmove.start.left
(but macro compatibility is maintained)
Surround

Changed and extended surround setups for Dolby formats
[SEQ-8796] Adapt surround X automation scaling for VBAP modes to full automation range

Markers and Range markers
[SEQ-7400] [SEQ-7817] Marker manager improvements

Buttons to switch between project markers, audio markers and warp markers
Audio markers are shown for the audio file of the currently selected object
Warp markers are shown for the currently selected object
Available columns and marker context menus depend from selected marker type mode (project, audio or warp
markers)
[SEQ-8330] Multiple open marker managers can have different settings (window positions, columns…) which are
individually saved

[SEQ-3400] Range markers and Range marker track added
Saved ranges are shown as Range markers in a separate track similar to the marker track
[SEQ-6917] Show marker lines across all tracks: Markers and Range markers can be extended by lines across all
track
[SEQ-7404] [SEQ-8800] Marker manager: Range markers are shown in the Marker Manager, the Range Manager
was removed
[SEQ-8783] New context menu entries for objects (Marker sub-menu): "Set Range marker over selected objects"
and "Set Range marker for each selected object" creates Range markers from selected object, the latter names
each Range marker after the object name
[SEQ-8791] No ripple for range markers: Range markers are not affected by ripple (object modes, copy/paste
commands with ripple)
[SEQ-8759] Unified keyboard shortcut for saving markers and range markers with Shift + Number key. Depending
on whether a range is selected, a range marker or a simple marker is set.
[SEQ-8880] Select several range markers by clicking the first and shift + clicking the last one
[SEQ-8812] Import ranges from wave projects
SEQ-8885 New menu commands in the "Play/Rec" > "Move play cursor" menu to select previous/next range
marker

Select previous range marker: Shift + Alt + Q
Select next  range marker : Shift + Alt + W

[SEQ-8879] The range 1+2 buttons above the time display in the transport window create/select 2 range markers
(R1 + R2) now

Marker + Range marker track
[SEQ-8811] Marker tracks are now also shown in Crossfade editor and WAV projects
[SEQ-8906] Project markers are, like range markers, shown on the marker track only now, not above the grid bar
any more
Marker and Range maker tracks can be toggled in the View menu
[SEQ-8860] There is a "track height" submenu in the marker and range marker track's context menu 

This is the only way to adjust marker track heights in wave projects
[SEQ-7999] Improved resizing of marker tracks without resizing other tracks

Import / Export
[SEQ-8790 Export selected range markers

A time selection option "Selected range markers" was added to the Export dialog allowing you to export each stored
range in a separate file

[SEQ-6734]   New option "Include AUX and Submix busses" for exporting selected tracks or multi-track export
When activated, each exported file additionally contains the effects of the Submix and AUX busses the track is
sending to
Options for including track and master effects are re-arranged and inverted for better consistency

[SEQ-8659] Load audio file
Files created by sample rate conversion will be saved to audio sub folder
Double file copies which happen when combined with other load options are avoided.

[SEQ-8240] Export presets will be saved and restored in an INZ container
Bugfixes

[SEQ-8702] "Details…" Button in message about referenced files outside the project folder did open "Project status"
instead of "Project files" dialog
[SEQ-8788] Interleaved file playback and export optimized
[SEQ-6517] AIFF or FLAC files were converted to 32bit WAV files on import instead of using original bit depth
[SEQ-8769] Edit Root VIP: Mixing edited project back to wave doesn't open a rename file dialog, the original wave
file will always be overwritten with the edited version
[SEQ-8765] Wrong latency compensation for surround export with more outputs than system devices
[SEQ-8794] Fixed date and time formats for export template place holder (YYYY-MM-DD and HH-MM)
[SEQ-8805] Export dialog: display issues with red focus triangle fixed
[SEQ-8896] Wave Export: project start position was not considered in wave time stamp



[SEQ-8909] Non-functional "Counter" variable button from Miscellaneous removed in the export template editor
Playback / Recording

[SEQ-8229]  Allow to switch off ASIO latency compensation for recording for special recording and monitoring situations in
the recording options

Disabled ASIO latency compensation is shown in status line at record start
[SEQ-6497]  [SEQ-8836] Audio setup: New option to show input peak meters for armed tracks automatically

[SEQ-8836] Behavior analog to tape monitoring: Input level is shown while stopped and while recording, output
level is shown when playing back.

[SEQ-6722] Input of any track can be selected for visualization
[SEQ-8523] Continuous playback while editing

Universal mouse mode: You can now move the play cursor with double click in the upper half of a track
Bugfixes

 was missing right channel[SEQ-8898] Internal stereo track recording with Zoom UAC-232 device
[SEQ-8229] Mouse wheel control for entering record offset in recording options was broken

Folder track improvements
Added more useful commands to a folder track's context menu [SEQ-8866]  

Commands for setting track height
Commands for source/destination selection
Moving track into or out of folder tracks

Automation writing for folder tracks is not supported anymore (except if it is a VCA master)
Improved display for subfolders in folder tracks
Bugfixes

Record button state was not shown correctly for folders with subfolders
Avoid duplicated folder name for neighboured folder tracks
Track drag'n'drop inconsistency when moving a track out of folder tracks
[SEQ-8614] Drag&Drop tracks out of a folder does not work in some cases
[SEQ-8614] Adjust routing while drag&drop tracks out or into a submix folder
[SEQ-8653] Issues with folders display and wave zoom out
[SEQ-8713] Empty folder was not visible in mixer after conversion to submix folder

 and don't allow to use them as reference track[SEQ-8351] Don't show folders inside folders in arranger wave view
Plug-ins

[SEQ-8526] Plug-In favorites and the list of recently used plug-ins are now user specific and will be saved and restored in an
INZ container
[SEQ-8870] Improved handling for VST3 folders (bundles)
Bugfixes

[SEQ-8806] Deliver latency compensation parameters to VST plugins (compensated song position, output delay) 
[SEQ-8546] External FX was visible in FX browser for offline processing
[SEQ-8834] ARA: movement of multiple objects is now updated in the ARA plug-in
[SEQ-8833] 'Remove ARA' in project status dialog did not remove ARA track plug-ins
[SEQ-8872] Crash when dragging object plug-ins while playing
[SEQ-8912] VST3 resize issues (e.g. Softube plug-ins)
[SEQ-8722] Possibly hidden message boxes in Denoiser dialog with activated "FX windows always on top
[SEQ-8700] SynchroArts Vocalign problems after Track Unfreeze

Automation
[SEQ-8546] PlugIn automation could disappear when loading mixer snapshots

Now the automation is kept in "inactive" state when loading another snapshot, where the plug-in is not present
It will be restored, when loading a snapshot with the corresponding plug-in
Attention: "Inactive" automation is just maintained for the current session, it's not saved with the project
Reminder: This is the same mechanism as already used, when moving objects to another track with active "Link
curves to objects", and there's no corresponding plug-in found

Bugfixes
Link curves to objects

[SEQ-8030] Issues with latch automation
[SEQ-8030] Improved curve handling between objects
[SEQ-7171] Curves were not copied with duplicate objects command (Ctrl+D)

[SEQ-8772] Disable curve/lane creation for internal FX if plug-in automation writing is disabled and plugin
parameters were changed from the plug-in GUI
[SEQ-8842] Wrong initial curve value when writing AUX send automation
[SEQ-8886] Issues with volume automation drawing in virtual wave projects

Curve mouse mode can now be used, if a volume curve is present
[SEQ-8886] Double click in curve mode sometimes could create and immediately delete a curve point

[SEQ-7171] "Duplicate objects" in object context menus is now also "Duplicate and move" like in Edit menu and no longer the old
"duplicate" command (without moving the copies)
[SEQ-8749] Fade in / out changes for audio objects are not blocked anymore by grouped video objects
[SEQ-8753] Improved handing for recently loaded or saved files

Now up to 16 entries in dedicated sub menu and start dialog
Changes are saved immediately and into separate .ini file, so the file history is maintained regardless of a reset of program
setting or a crash
Add default shortcut Ctrl+Backspace for quick access to list of recent files

[SEQ-8743] [SEQ-8881] Further fine-tuning of display on HDPI/4k monitors when using application scaling (still under construction)
Bugfixes

[SEQ-8676] VBAP initialisation for surround AUXes was missing, if track main output was stereo
[SEQ-8908] EN version only: wrong formatted tooltip for stop button in transport window
[SEQ-8878] EN minor text adaptions for reset in color setup dialog
[SEQ-8789] "Remove unused samples" and "D didn't work correctly for interleaved andelete" directly after recording 
compressed files
[SEQ-8837] Plug-in name in arranger plug-in slots and automation lanes was truncated too early



Status line messages didn't work correctly in some context menus[SEQ-8351] 
[SEQ-8766] Issues with SMPTE conversion for 29.97 drop frame
[SEQ-8748] Internal FX on objects didn't open its dialog after working in spectral mouse mode
[SEQ-8799] Missing monitoring section update for plug-in bypass
[SEQ-8765] Skip unnecessary sample rate change dialog in empty projects
[SEQ-8844] Mark project as changed after loading track/master FX presets
Surround

[SEQ-8823] Show last saved or loaded preset for pan / surround pan dialogs
[SEQ-8801] Disabling "Create fades for new objects when Auto Crossfade is active" program option did not work
when interleaved files were imported, fades were also created with disabled option and Auto-Crossfade active
[SEQ-8503] Surround file presets were not deleted to recycle bin
[SEQ-8503] Surround setup dialog didn't show the name of the last saved preset file name
[SEQ-8692] Disable load/save for track presets for surround tracks

Arranger
[SEQ-8754] Missing reset of folder color in case of just deleting parent folder track
[SEQ-8775] Object end changes by moving start before previous object could not be reverted anymore by moving
mouse back
[SEQ-8802] Invalid waveform graphics after using Spectral editing mouse mode
[SEQ-8770] Graphical glitches in folder tracks while horizontal mouse scrolling
[SEQ-8839] Display issues with last sample of right channel in stereo wave files
[SEQ-8711] Flickering of take objects text in take lanes with mouse operations
[SEQ-8379] Vertical zoom could jump after resizing the project window

[SEQ-8851] Crash with JAWS screenreader in quantize settings
[SEQ-8588] Qt peakmeter scaling issues
Crossfade Editor

[SEQ-8464] Fix object drawing for vertical auto zoom
Mixer

[SEQ-6514] Inconsistencies with solo handling and multiple outputs (e.g. when routing a track to stereo and
surround master)
[SEQ-8273] Missing group numbers for mixer faders
[SEQ-9011] Issues with older mixer skins and controls at right border
[SEQ-8815] Mixer didn't show active monitoring button states when its vertical size was as small as possible.
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[SEQ-8867] Improved disabling of commands given while recording with playback is active
Export via preset is also disabled now.
Paste commands are disabled now (they trigger a status line message "This command is not available if a recording with
simultaneous playback is running.")

[SEQ-8861] New take naming template "(take name)_(tracknumber)"
Track number now uses 3 digits in projects with more than 99 tracks

Use ini setting [Factors] Force3DigitsForRecordTrackNumber=1 to always use 3 digits
(Automatic take naming already can be set to 3 digits in the advanced recording options)

[SEQ-8788] Interleaved file playback and export optimized
Bugfixes

[SEQ-8857] Accessibility: Enter and End key didn't work in mixer anymore (since Build 24218)
[SEQ-8869] Display issues with (missing) track editor in wave projects
[SEQ-8867] New focus handling for docking windows (activate inactive window instead of closing it) was missing for e.g.
screen keyboard, FX browser and info manager
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Enterprise version / maintenance contract only: FX I/O Matrix for plug-ins
[SEQ-8736] Added help button
[SEQ-8658] Added tool tips
[SEQ-8735] Wrong reset for more plugin channels than track channels or vice versa

[SEQ-8541] ARA support for RipX DAW (under construction)
[SEQ-8700] ARA support for VocALign 6 Pro
[SEQ-6021] Strip Silence: silence detection reworked
[SEQ-8714] Improved performance after closing system dialogs or inside of menu / keyboard setup
Improvements of display on HDPI/4k monitors when using application scaling (still under construction)
Bugfixes

Recording
[SEQ-8727] Crashes when record arming more than 256 tracks
[SEQ-8727] Crash while record start after exchange USB hard disc
[SEQ-8712] GUI Performance issue with interleaved recording

Arranger
[SEQ-8737] Wrong object start when dropping multiple audio files from explorer
[SEQ-8684] Casual wrong hiding of newly created tracks
[SEQ-8763] Re-ordering tracks in CD arrangement mode didn't work anymore

[SEQ-8657] Crossfade editor: footer volume display was still visible and active
Export



[SEQ-8731] Issues with file names for multi format export with choose filename later
[SEQ-8734] Mono export issues
[SEQ-8765] Latency compensation issues with realtime export
[SEQ-8708] Export dialog - realtime export

Possible endless requester "project is already open"
Option "from project start to last object" didn't work correctly

Mixer / Plug-ins
[SEQ-8707] Wrong plugin editor size after switching from parameter dialog
[SEQ-8697] Cursor drawing glitches in marker lane after bypassing plugins
[SEQ-8741] Mixer button "Hide tracks" didn't work anymore
[SEQ-8745] Routing of just added tracks could become corrupted, when adding or re-ordering other tracks
[SEQ-8729] Crash in AutoAlignPost(ARA) while using object time stretching

Surround
[SEQ-8755] Wrong mixer surround peakmeter display for more than 12 channels
[SEQ-8728] Monitoring section: upmix matrix dialog from stereo master to surround was not available anymore
[SEQ-8747] Disable primary output editing for surround busses (could result in crashes)
[SEQ-8684] Adding surround folders created several undo steps

Automation
[SEQ-8694] After switching between object and track automation the deactivated automation could still have
selected points that responded to commands
[SEQ-8773] Missing updates for automation button of internal FX

[SEQ-6842] VSTi playback could be silent after switching engines
[SEQ-8367] Time display: text was not centered

06/25/2024 Sequoia 17.1 Build 24216

Enterprise version / maintenance contract only
[SEQ-5669] FX I/O Matrix for surround plug-ins

Open it from the "Plug-in" menu of a VST Plugin dialog.
There are two matrices to route track audio channels into plug-in input channels and plug-in output channels to
track audio channels. Use it to correct channel assignments.
Reset buttons to restore the default routings and Delete buttons to remove all routings are provided for each matrix
and for both matrices at once.
Note that side-chain inputs are not taken into account yet.

Import / Export
Export dialog

[SEQ-8061] New properties in file naming template editor
New "Channel count" property: number of audio channels of exported file
New more "fine-grained" date placeholders

[SEQ-8061] Improved properties in file naming template editor
"Bit depth" placeholder now without "Bit" unit for more flexibility
Two separate "Sample rate" placeholders, in Hz and kHz, both without "Hz"/"kHz" unit for more flexibility
Legacy bit depth and sample rate placeholders will be replaced automatically when loading old export
presets or naming template presets

[SEQ-8060] "Put in Subfolder" has also a template editor like the one for file name now (instead of just an edit field)
Export job list improvements based on various user feedback

[SEQ-8344] Several fixes and improvements
Adding jobs to the list is possible by double click now
Multiple selection of jobs is considered by the "start" "reset" and "remove" job buttons now

[SEQ-8409] Several usability fixes with project chooser widget
Adds projects with enter key when they are selected

[SEQ-8370] Improved keyboard handling / accessibility for export list: Navigate through export list with arrow keys,
operate buttons (start, reset, remove) with enter key.
Bugfixes

[SEQ-8391] Order of added projects is kept now.
[SEQ-4111] New audio files are now automatically placed into an "Audio" sub folder of the project folder
[SEQ-8329] Importing multiple interleaved wavs now triggers a dialog to choose to import them below each other or in a row

Fixed an issue where multiple wavs imported below each other may import onto a surround folder
Bugfixes

[SEQ-8228] Export into Surround+Stereo file failed when Stereo Master and Surround Master are routed to the
same device number
[SEQ-8586] Track freeze / unfreeze commands didn't work for multiple tracks
[SEQ-8586] Wrong track name after unfreeze
[SEQ-8558] Export dialog: Wave with codec didn't work
[SEQ-8674] Project compatiblity warning was shown for each clipstore entry when saving projects created in old
versions
[SEQ-8650] Issues with BWF MP2 export

Automation 
[SEQ-7280] Move automation points via object move shortcuts (Ctrl+Alt+1/2) now also works with step width 2 and allows
value change with volume change shortcut (Ctrl+Alt+7/8)
[SEQ-8340] View options: Scaling the waveform with fades/curves now has an additional scaling option for object fades and
volume curves only (without track volume curves)

This new option also is the new default setting
[SEQ-8075] [SEQ-6985] New commands in automation menu to show only Vol/Pan/AUX/EQ/Plug-in automation lanes
[SEQ-8578] Don't show automation in crossfade editor



Bugfixes
Link curves to objects

[SEQ-8077] Creation of several automation points with wrong values when using timestretch in object
editor
[SEQ-8050] Avoid creating automation points in empty curves
[SEQ-8029] Moving objects with menu commands or keyboard shortcuts could delete Latch automation
[SEQ-7712] Objects moved to another track could loose object automation
[SEQ-7712] Wrong automation lane display after moving objects with automation behind project end
[SEQ-8649] Issues with latch automation and "Link curves to objects" after playback stop

[SEQ-8587] Show automation lanes command didn't work for multiple tracks
[SEQ-8152] Automation preview didn't work correctly for AUX sends

Arranger / Track editor 
[SEQ-7886] Submix folder handling via menu and shortcuts
[SEQ-8354] New menu command to select only the active track only (default shortcut Shift+Alt+Enter, only available after
resetting shortcuts or ini)
[SEQ-8524] With "Continuous playback while editing" the cut mouse mode shows the scissor cursor also while playback is
running
[SEQ-8424] Reverted to old style range cursor (but with high DPI adaption)
[SEQ-8246] Lock groups are displayed as colored spot on lock buttons now
[SEQ-8518] Pasting a range with skip left now adjusts at the right border (and gives an error message, if pasted range or
linked objects would drop below position 0)
Bugfixes

[SEQ-8300] Timestretch / pitch-shift mouse mode: The object end handle at right object border is shown even if the
end is covered by the next object

This enables the user to edit the time-stretch factor in this situation
Link markers to objects

[SEQ-8522] Issues with some object modes when arranging objects via menu Object > Move
objects/crossfade
[SEQ-8535] Ignores markers following the moved objects when "Link until silence" is active
[SEQ-8198] Markers with reference track "All" were not moved when inserting objects

Folder tracks
[SEQ-8556] Recording track color highlight was not displayed in closed folder tracks
[SEQ-8570] Wrong object border display in folder tracks with reference track
[SEQ-8317] Waveform did not zoom in closed folders
[SEQ-8316] Resizing of multiple tracks could open folders and showed hidden tracks
[SEQ-8401] Very small objects were not displayed in folder view
[SEQ-8623] Menu for folder refrence track only supported up to 126 contained tracks and didn't use menu
columns
[SEQ-8601] Routing issues when adding new tracks inside or after submix folder

[SEQ-8456] Optimized object group number display for small objects
[SEQ-8517] Optimized object handle positions
[SEQ-8590] Issues with object/start end handling in footer for small objects
[SEQ-8604] Context menu for peakmeter was missing in arranger and track editor
[SEQ-8065] Track editor updates

Dual pan was missing in vertical skin
Phase button didn't work in horizontal skin with active dual pan
Blue fader handles for busses similar to mixer

[SEQ-8646] Mouse wheel lock for faders and knobs after scrolling in track head didn't work anymore
[SEQ-8643] Graphic issues in track head with dual pan
[SEQ-8378] Track number in submix folders was hard to read in Carbon skin
[SEQ-8686] Issues with deleting several objects at once and slip left

Surround handling
[SEQ-8494] [SEQ-8550] Better access to the Surround downmix matrix from mixer AUX/Output area

Tooltip for Shift+Right click on AUX send
Menu command in the AUX send menu renamed to "Surround downmix matrix"
Menu commands to access downmix matrix in track output menu added

[SEQ-8510] Phase invert option for surround sources
Available in left click menu in mixer panning section
Display in surround pan dialog via tab menu

[SEQ-8514] New menu entry "Remove output routing" in tabs of track pan dialog (for non-primary outputs only)
[SEQ-8495] Default source positions and surround pan mode for 3d Surround setups reworked

3D VBAP, stereo track outputs to according speaker, mono tracks to center speaker 
[SEQ-8615] Initial surround panner setup for tracks can now be controlled via presets containing the text "Default", search
order is

default_mono_/default_stereo_ + Surround-Presetname (gss), e.g. "default_mono_5_1 ITU"
 Use the "Save as default" entry in the preset menu

Previous template.vip mechanism is removed
Bugfixes

[SEQ-8318] Interleaved / surround objects drawing issues
[SEQ-8360] Object handling improvements for surround folders and folders with reference track

Select next / previous object shortcuts
Zoom to selected objects
Preview mouse mode
Fade handles menu
Audio marker display

[SEQ-8319] Importing interleaved wave files as (surround) folders sometimes broke already existing folders
[SEQ-5218] Importing an interleaved wave file on a surround folder with different channel count now show a



warning message about creation of a new surround folder
[SEQ-8513] Some routing issues in surround panner (doubled primary out display, bypass inconsistencies)
[SEQ-8287] Surround folder missing display for incomplete mute/solo/monitoring states
[SEQ-8287] Surround folder monitoring switch didn't work
[SEQ-8534] Selecting a plug-in as surround panner closed the panning dialog
[SEQ-8555] Opening online help with F1 in pan dialogs was broken
[SEQ-8478] Some issues with LFE loading from surround setups fixed
[SEQ-8514] Missing updates of tabs in pan dialog after using output/AUX bypass or reset in mixer
[SEQ-8603] Space didn't trigger playback in pan dialogs
[SEQ-8527] Surround and pan dialogs flickered while moving
[SEQ-6241] No routing matrix when routing from surround bus / folder to stereo (did only work for surround
masters)

When inserting the first surround bus the dialog shows "Surround master" according to existing[SEQ-6241] 
functionality
[SEQ-8554] Copy-Paste surround folder: Faders were not linked in pasted folder

[SEQ-8615] Mixer setup changes
New option "Force mono tracks"
This way you can benefit of the above surround preset handling for mono tracks
New preset "Surround (Mono Tracks)"
Left click in mixer now opens drop down, right click opens dialog

Take handling / Take lanes
[SEQ-8630] Allow to delete obsolete or all take entries in project status dialog - added progress bar
[SEQ-8613] New S/D cut option: Copy takes with cut - default off. Prevents possible performance issues when using a lot of
takes in S/D Cut.
[SEQ-8080] Audio and MIDI takes can be switched together in take lanes
[SEQ-8617] Snap didn't work in take lanes
[SEQ-8613] Take number did grow when just moving objects, possibly leading to delayed playback start

Window handling / Docking
[SEQ-8405] Use Ctrl key while dragging a window to avoid docking
[SEQ-8395] Horizontal mixer size is stored globally now

 Disabled horizontal adaption of mixer window when changing projects or adding tracks
[SEQ-8445] "log" and "exp" naming for fade curves swapped to be consistent with common naming
[SEQ-8540] ARA support for Syncro Arts Revoice Pro Link 5
Bugfixes

[SEQ-8299] Marker manager: Sorting by reference track fixed
[SEQ-8410] MuSyC: “Play always Source…” didn’t work with transport console
Crossfade Editor

[SEQ-8350]  Issues with collision detection
[SEQ-8156]  Source-Destination special mode now only shows single view
[SEQ-8682]  F10 could not be used as shortcut anymore
[SEQ-8417] Cursor key handling disabled, e.g. to avoid conflicts with arranger zoom commands

In Sequoia you can deactivate "Ignore mixer keys" for old behavior
[SEQ-8580] Folders were displayed with black background in crossfade editor

[SEQ-8156]  (DE only) Source-Destination special mode menu entry now "Source-Destination-Schnittmodus"
[SEQ-8536] Macro "crossfade.active" ignored on/off parameter, although stated as supported in MacroCommand.list
[SEQ-8019] Take Lanes: Take lane state wasn't restored when closing the crossfade editor
[SEQ-8336] Crash when playing objects with the same compressed file on different tracks and multiple CPU cores used
[SEQ-8400] Possible wrong grid bar text color after skin change and restart of program
[SEQ-8473] After deleting a recording, 'Stereo Pan' could be displayed in the object
Mixer

[SEQ-8355] Sends On Fader didn't show the fader handle in the target AUX track
[SEQ-8374] Only first surround bus fader handle was colored blue
[SEQ-8374] Improved fader handle reset after deactivating Sends-on-fader
[SEQ-8355] AUX send to same track can't be activated anymore
[SEQ-8303] Shift-click for finetune tooltip description was missing for some mixer, track editor and object editor
controls
[SEQ-8385] Shortcut Ctrl+A for selecting all tracks now considers tracks that are only visible in the mixer if the
mixer has focus

ARA
[SEQ-8436] Audio to MIDI: Creating a new track if needed didn't work anymore
[SEQ-8472] Invalid ARA object state after unfreeze
[SEQ-8386] Melodyne: In some projects with tempo markers, Melodyne no longer showed blobs

Time display
[SEQ-8549] Lyrics marker display flickered while recording
[SEQ-8568] Graphic glitches with time unit milliseconds

[SEQ-6784] Missing file menu entry for range list export added
[SEQ-8552] Prevent freeze command for master and folder tracks
[SEQ-8258] After closing Spectral Cleaning without any edits, no FX file will be created

Confusing SC marker in objects is not used anymore
Applied SC can be seen by audio markers

[SEQ-8591] Several scaling and drawing issues with nudge edit in toolbar
[SEQ-8648] Some language adaptions (DE/EN/FR)
[SEQ-8569] Prevent sorting by columns in routing manager
[SEQ-8158] HWC focus was changed for audio preview in file or soundpool manager
[SEQ-8612] ARA: Problems with Vocalign Ultra if inserting into a project after removing it before
[SEQ-8531] Possibly corrupted mixer layout after maximizing
[SEQ-8633] Fixes some inconsistencies betweeen main menu, offline FX, automation and help menu



[SEQ-8609] Possible focus issues after closing crossfade editor
[SEQ-8554] Several fixes for copy&paste of tracks (e.g. copy of missing VSTi or AUX busses)

05/13/2024 Sequoia 17.0.4 Build 23433

[SEQ-8274] Improved "Project status" dialog  
Shows number of stored takes in project
ARA Info now also works for other plug-ins than Melodyne
[SEQ-8630] Allow to delete ARA, obsolete or all take entries with "Clean up" button

Bugfixes
[SEQ-8571] Issues with take lane editing and activated SD cut option "Copy markers with cut"
[SEQ-8592] User administration didn't work correctly for some settings since Sequoia 17
[SEQ-8592] Command "Reset program settings to default" didn't work correctly with user administration
[SEQ-8460] Possible crashes when closing projects after using the Clip Manager
[SEQ-8334] Carbon: wave editor grid was hardly visible
[SEQ-8610] [SEQ-8607] FR language text fixes and improvements
[SEQ-8620] Crash after inserting external FX from FX browser
[SEQ-8602] Possible audio distortion when playing objects with AUX send
[SEQ-8595] Export dialog: 'Split at marker' could overwrite previously created files
[SEQ-8538] Grid and marker track didn't scroll if the first visible track was hidden
[SEQ-8528] Crash after changing speaker configuration from surround pan dialog
[SEQ-8525] Automatic plug-in scan in system and user directories could not be switched off anymore
[SEQ-8532] Crash when adding VST instrument by drag and drop
[SEQ-8488] Phase invert button in mixer could not be operated with Enter key
[SEQ-8505] Crash with marker list export fixed
Multi-Format-Export (exporting more than one format at once)

[SEQ-8519] Split at marker option didn't work correctly
[SEQ-8475] Exporting of selected objects didn't work correctly
[SEQ-8504] Writing ID3 and other meta data didn't work



03/12/2024 Sequoia 17.0.3 Build 23431

[SEQ-8411] New command "Reset program settings to default" in help menu, does the same as loading the default INZ container in
start selection dialog or program settings
[SEQ-8333] Export naming templates: marker number placeholder now defaults to 2 digits again (using more digits only if total
number of markers exceeds 99)
[SEQ-8339] MIDI SysEx is now activated automatically without message box when using HWC or MMC
Bugfixes

[SEQ-8463] Removed Print Center still was visible
[SEQ-8349] M4A/AAC Import: 'sample count zero' error after importing more than one file
[SEQ-8449] Range based copy and including automation data created rampsS/D cut 
[SEQ-8452] Object plug-in browser always inserted in first slot, not after existing plug-ins
[SEQ-8440] Crash after editing automation curves 
[SEQ-8246] Track head mute/solo/record/lock states were not correctly displayed immediately after skin change 
[SEQ-8397] Problems with drag'n'drop on the last track when it was an empty folder
[SEQ-8341] Internal FX dialogs could not be brought in front when re-opening 
[SEQ-8363] VSTi: No 'project changed' state was set after inserting a VST instrument
[SEQ-8394] Possible crashes in AAF Export with option "Copy only the used audio material"
[SEQ-8466] MIDI Editor: Possible Crash when notes were selected and the controller editor window was too small
[SEQ-8381] Export dialog: Naming templates didn't work correctly with realtime export
[SEQ-6108] Problems after deleting and rewriting of an automation from internal plugin GUI
[SEQ-8332] Creating a new project with a new name from a template triggered the compatibility warning about saving older
versions projects
[SEQ-6128] No update of selection marks in mixer after drag'n'drop of plug-ins
[SEQ-8472] SpectraLayers: crash during unfreeze fixed
[SEQ-8450] Video recording state was not displayed correctly in track head or mixer
[SEQ-8328] Export in multiple formats didn't work for multi-track export
[SEQ-8296] Some filename templates didn't work correctly for multi-track export
[SEQ-8320] Duplicate and copy of folder tracks didn't work correctly
[SEQ-8415] Possible wrong export file names if they contained '.' in object or project names
[SEQ-7911] Volume automation was modified when drawing in an empty lane



02/02/2024 Sequoia 17.0.2 Build 23428

[SEQ-8393] VST MIDI Send to another track didn't work anymore
[SEQ-8365] Some VST3-Plugins didn't work as MIDI-Plugins (e.g. BlueArp)
[SEQ-8371] Crashes when changing DeNoiser sample while playback
[SEQ-8412] Play cursor flickered when changing the start position during playback
[SEQ-8384] Line breaks entered in the info manager for object comments were not displayed correctly in the object editor
[SEQ-8366] ARA: Program freeze with VocAlign plugins after inserting as track effect in empty track
[SEQ-8416] ARA: Crash after editing in the info manager
[SEQ-8357] Export dialog: Export to 32bit float with glue selected objects option active was exported as 24 Bit instead.
[SEQ-8406] Wrong object footer text color for folders in Carbon skin
[SEQ-8400] Wrong arrangement text color after skin change and restart of program
[SEQ-8398] Some corrected translations (EN)
[SEQ-8380] Muted objects drawn with half wave forms created graphical glitch
[SEQ-8369] Wrong AUX send coloring in mixer with -inf send level
[SEQ-8346] Marker line was drawn while moving CD and punch markers
[SEQ-8408] Duplicated drop-down display in object editor
[SEQ-8274] Possible issue with creating too many take entries after moving recorded objects



01/15/2024 Sequoia 17.0.1 Build 23424

[SEQ-8023] Start dialog: "What's new" link to corresponding help page added
[SEQ-7282] Multiple track selection with shortcuts in arranger and mixer

New commands (under Tracks > More > Select tracks)
"Select all tracks"
"Add previous track to selection" (shortcut Shift + Alt + Up)
"Add next track to selection" (shortcut Shift + Alt + Down)

Use Ctrl + A can to select all tracks
in the mixer
in project window, if track name has focus

[SEQ-7944] New main menu commands added that were only present in context menus before
Menu Edit > Tempo >Tap tempo... for the Tap Tempo Dialog from the tempo menu of the transport console
Menu Edit > Crossfade > Crossfade editing >Log./exp. from the object fade handle context menu
Menu Track > More > Track color… for the color menu from the track head color area

[SEQ-8255] Skin change now also resets default track / object colors
[SEQ-7423] A vertical line is drawn while moving a tempo marker 
[SEQ-7791] Separator between tracks optimized - further fine-tuning
Bugfixes

[SEQ-8290] Bug with "Link objects to the left" rippling object mode: Deleting object caused movement of objects at same
position in other tracks
[SEQ-8211] Save Complete VIP: Problems with interleaved files and virtual stereo files
[SEQ-8311] Add some missing localisations (ES/FR)
[SEQ-8302] Column widths in Marker manager were not restored
[SEQ-8289] Group numbers in objects were hidden even when enough space was available
[SEQ-8256] Zoom to selected objects didn't zoom completely if the selection included all tracks
Plug-ins / FX 

[SEQ-8315] Crash when opening EQ in surround tracks
[SEQ-8293] Playback dropouts with FabFilter plug-ins used on objects
[SEQ-8307] Problems to stop playback with the space key in Soundtoys plug-ins
[SEQ-8288] Pasting a copied object plug-in chain to multiple selected objects inserted the plug-in (chain) on the
active object only
[SEQ-8337| Mixing on neighbouring mono channels of an output device caused crackling for external FX
[SEQ-8257] Track FX chain reset and preset loading via Track FX button menu didn't work for multiple selected
tracks
[SEQ-8356] Problems with VST3 Plug-ins without parameter name handling
[SEQ-8348] UADx-Plugins didn't recall their settings from project when using latest UADx update
[SEQ-7804] ARA VocAlignUltra state was not completely restored after project loading (fix also requires latest
VocAlign update v 1.3.67.1)

Mixer
[SEQ-8306] Removed tooltip for scrollbar in mixer
[SEQ-8322] Some fixes for restoring mixer window size after loading a project
Sends on Fader

[SEQ-8248] Sends on Fader could cause overwriting of AUX send after using the "visible" checkbox in
AUX send dialog
[SEQ-8313] Surround master AUX sends were activated with Sends on Fader
[SEQ-8314] Issues with AUX automation (e.g. writing automation in surround busses)

Recording
[SEQ-8284] Recording settings: "Format" label would be visually covered by group box frame (EN localisation only)
[SEQ-8232] Warning added for attempts to use track output recording and the performance option "Deactivate FX
on empty or silent tracks for ASIO" on

Import / Export
[SEQ-8239] Screen flickering when exporting multiple wave files without opening them
[SEQ-8254] Improved overwrite warning if files are already opened
[SEQ-8294] Glue Objects until silence: Selected objects without cuts were not processed
[SEQ-8338] AAF/MXF Import: Embedded audio was always silent

MIDI / VSTi
[SEQ-8356] MIDI Plug-ins didn't work anymore from build 23418
[SEQ-8347] VSTi: Hanging notes with Yamaha NoteOff conversion if track MIDI output channel was set

Crossfade Editor
[SEQ-8295] Vertical scrolling with mouse wheel didn't work after hidden tracks
[SEQ-8298] Track editor command / button is now disabled
[SEQ-8298] Mixer keys (Cursor keys, Pos1,...) were not handled



12/07/2023 Sequoia 17.0 Build 23418 - Release

General changes
[SEQ-8054] new Sequoia 17 copy protection

Keys starting with P2- aren't used anymore
Sequoia License Central can be used for activating trial license

All maintenance contract only features of Sequoia 16 are available for all users now
Video output on Blackmagic video cards
Auto-conforming

Allows transferring of the edits of one track of a reference file to the first object of all tracks selected for
processing in the current project
Import possible from EDL (CMX3600)

Batch / Watch folder processing
New option for removing silence before and after audio material

Configure up to 8 independent visualization sources
Custom toolbar icons for macros can be defined (similar to custom icons for menu commands)
Time display

New option for subframe time display for SMPTE formats in project options
New time display commands for timestamp of current object and time difference to original timestamp

EDL import/export of EDLs compatible with Blackmagic Design's DaVinci Resolve
64 Bit version only, no 32 bit version anymore

Sequoia_u_x64.exe renamed to Sequoia_x64.exe. Please consider this, when using own links or scripts.
Italian language is not available anymore
[SEQ-7841] New HTML help system, which opens in standard system browser
[SEQ-7154] separate *Support* tab in the *About Sequoia...* dialog

new main menu entry *Help > Support...* which directly leads to the new *Support* tab
Project compatiblity warnings

[SEQ-7819] when loading current projects in older program versions
[SEQ-7771] when opening/saving projects created in older versions

[SEQ-8249] [SEQ-7616] Changed several default program settings
Following settings are default active now

Scan user and system VST folders automatically
Recording: Save each take in a new file 
Destructive Effects: Generate a new file for each FX calculation
Crossfade editor: Default relative zoom width for crossfades 10%
Metronome: Default volume -10 dB
TrackSpeed: Default buffering time 2 s
No automatic volume fader mode change for MIDI tracks
Soft split for MIDI objects
No default assignment of NumLock key for scrubbing
Reduced default number of cores for multi CPU handling
Knob characteristics same as faders
Vertically optimize MIDI-note display
Universal mouse mode
Spectrogram: Logarithmical scaling
99 undo steps
Use middle mouse button for project navigation
Filled spectroscope visualization (might require updated workspaces)

[SEQ-8249] ASIO dropout warnings are default activated again
New option "Send analysis data to MAGIX", can be deactivated in general program settings
[SEQ-5653] .ini files for program settings and plugin favorites are saved instantly, not just at end of a program session. So
changes in the settings are maintained even after a crash.

Previous .ini files are kept as *_backup.ini and may be restored manually by renaming the files
[SEQ-8277] Reset stored window positons of several windows (Export, Crossfade editor) when using "All windows to
mainscreen" command with pressed Shift key
[SEQ-7936] The path of the active project file is logged in the crash.log in case of a crash event
[SEQ-8122] Updated to Qt 6 framework
[SEQ-7980]  forPerformance improvements

Use of many files (e.g. with every take in a new file) or many objects
Recording / playback with many tracks / devices
Undo with object EQ on many objects
[SEQ-7355] projects containing a lot of automation data

Faster saving and loading of projects
Faster drawing automation data e.g. at wide zoom levels
[SEQ-7526] Faster undo creation by copying only changed track automation curves

SEQ-6594 Faster moving, deleting or adding tracks
SEQ-7047 Faster creation of new projects, faster skin change

Recording / Playback
[SEQ-6806] Support for 384 mono I/O (experimental up to 512)
[SEQ-7980] More than 64 Mono In or Out Devices are grouped into several submenus
[SEQ-8010] Support for  (depending on audio device) - level still can be adjustedASIO float recording of clipped audio
after recording



[SEQ-7991] Support for IK AXE ASIO device with only one input and three output channels, 
Last channel of devices with odd channel count can be accessed in general

[SEQ-7798] New playback option added to pause autoscroll until play stop when clicking in the arranger
[SEQ-7702] Pause Autoscroll when 'Continuous playback while editing' is active
Only changes in the timeline made during recording are undone when cancelling the recording. Other changes (e.g. cuts or
automation data) are preserved
SEQ-6452 Playback doesn't stop anymore at range end for continuous playback mode (when loop mode isn't active)

Record pause didn't work in "Continuous playback while editing" mode SEQ-6970 
SEQ-5820 Edit while Record: adapted wording + toolbar button
SEQ-6682 Take Manager: adapt object copies for copy & pasting tracks
SEQ-6958 Record in loop mode didn't switch to most recent take
SEQ-6559 No   display limit while recording anymoreComparisonics



[SEQ-6605]  for comping audio recordingsTake Lanes
Open via button on the left or command Track "Show take lanes" (default shortcut Ctrl+Shift+Enter)

Replaces old Take Composer function
Take lanes can be shown for just one track

Shows all available takes for all objects in a track
In Universal mouse mode takes can be copied/activated by single click, drawing a range or dragging borders of used takes

this is similar to using the scissor tool in the old Take Composer
With grouped objects on several tracks takes are exchanged on all tracks (multi-track comping)

If takes are not available on other tracks, they are marked with red background
There's an error display in the status bar, if you try to use them

Solo button on track head of take lane
In Range mouse mode you can use Ctrl + C for copying ranges, e.g. from other time positions (without multi-track handling
yet!)
[SEQ-7809] Unused take entries are removed now after deleting objects or loading projects from older versions
[SEQ-7767] Take Composer menu entries and button removed
[SEQ-7736] Tooltips for take lanes added
[SEQ-7735] Constant vertical scroll speed - independent of track height
[SEQ-7974] Take Lanes for MIDI objects

 [SEQ-7765] Cutting takes with grouped recordings doesn't break the grouping anymore if a take is missing for some tracks
[SEQ-7670] Lanes are now restored after loading a project

[SEQ-7040]  markersAudioWarp
Allows stretching of objects audio content (in addition to the project tempo map)
Select the Timestretch mouse mode to edit warp markers

Click into an object for adding a Warp marker at the cursor position
Click and drag an existing Warp marker in the upper half of the object for stretching the object
Click and drag an existing Warp marker in the lower half of the object for moving the anchor position of the warp
marker
Right click on an existing Warp marker to show a context menu

The warp markers are stored in the object, not in the object's audio file. Although they are displayed in the object like audio
markers they could differ for different objects referring to the same audio file.

Copying an object will copy the warp markers, too
Warp markers currently require the Musical tempo adjustment option set to active which is done automatically when adding
a warp marker
Timestretching an object with activated musical adjustment is now possible thanks to the Warp markers
Load/save and undo/redo is supported

[SEQ-7419] Marker Track
Project markers are now displayed in dedicated track

Other markers like CD track indices or Tempo markers still are displayed in the marker bar on top
Track is resizable, displaying all markers according to available vertical space for improved overview e.g. with many markers
Multi-selection of markers is possible for moving, deleting or color assignment
Individual marker colors can be changed via context menu on markers, in marker track head or in marker manager
In the track head there are some useful commands e.g. for creating new markers
[SEQ-7690] Marker lines drawn on top of all tracks when moving markers

Arranger 
Skin update

New Carbon & Canis Skin
Graphical elements have new coloring and flat design
Track Editor has a new layout
Mixer master fader and peakmeter have now the same height as the tracks
Track Editor & Mixer peakmeter layout changed. Peak indicators are now side by side, scale is on the left
Playcursor has a width of 3 pixels for better visibility

Camo, StarGray and 'Style v10' skins won't be delivered anymore with the program
Old inverted range display in older skins like StarGray is not supported anymore and automatically updated to new
semitransparent display

New option for showing new object text footer. Benefit: Waveform is not covered by texts and object lock anymore
New option for showing object volume in object
New option to disable vertical arranger zoom when resizing window (vertical arranger zoom is not anymore influenced by
docking manager height)
Object volume & crossfade handles - option for displaying them always on top object border (view options)
Autoscroll for moving objects or tracks during playback
Crossfade handling

New mouse cursors for changing start, end and crossfade position of objects
New crossfade moving behavior. Object borders and crossfades can now be moved independently.
Crossfades can be moved without moving the object itself (object overlapping area)
Object fade length adapts now to object resizing when fade-in and fade-out collide

With active 'continuous playback while editing' a new range isn't created anymore by copy-pasting objects
Moving view via dragging middle mouse button (works in Arranger and MIDI Editor). New option in mouse wheel settings
[SEQ-7835] Heights of lanes are also reset when resetting track heights
[SEQ-7811] TS/PS mouse mode always allows range editing similar to universal mode now, independent from previous
mouse mode
[SEQ-7727] Scrolling with mouse wheel is now pixel proportional
[SEQ-6421] Alternating track colors now includes selected tracks as well
Folder Tracks

[SEQ-6567] Track context menu: new Move to folder track functions



New in Track and Folder track menu: Duplicate Tracks
[SEQ-6846] Control monitoring status of contained tracks

If not all contained tracks are monitored, only the border of a folder's monitoring button is shown activated
[SEQ-7736] Tooltips for universal mouse mode added

only visible in extended tool tips mode
[SEQ-7641] Old visual feedback for locked objects via [Factors]OldStyleLockMark=1
[SEQ-5651] Updated mouse cursors in arranger, docker, and MIDI editor to better show what mouse dragging will do
depending on the area you mouse over

Drawing a selection frame
Selecting a range
Drawing a curve
Moving an item

[SEQ-8023] Changed default object background color (Carbon only)
[SEQ-7791] Optimized separator between tracks
[SEQ-7998] Hovering mouse over grid bar shows range cursor
[SEQ-8031] Restructured object menu

Access to recently used object menu commands
[SEQ-7818] In object footer, a text "Warp" is displayed if at least one AudioWarp marker is present in object
SEQ-2916 Extended mouse overs (Zoom, Volume, Pan,... )
SEQ-6841 Reduced flickering of play cursor + drawing fixes
SEQ-6058 Fix for object footer display in surround folder
SEQ-6843 Improved mouse handling for object's crossfade area
SEQ-6740 Object drawing glitches - fixed
SEQ-6555 Inserting folder after folder goes wrong - fixed
SEQ-6594 Improved track exchange speed when moving multiple tracks + show wait cursor
SEQ-6872 Draw always full object when "Draw while move" is activated
SEQ-2997 Prevent placing audio or MIDI objects on a video track, and also the placement of video objects in non-video
tracks.
SEQ-7079 Video tracks can be added via menu Track > Add tracks  > Video track
SEQ-6394 Arrangement text and separator line for marking upper and lower track area in Universal Mouse mode is only
shown on selected track
SEQ-7143 Improved beat and beat sub-division display in grid
SEQ-7153 Folder symbol for empty folder tracks fixed
SEQ-6410 Sub folders of folder tracks don't expand automatically anymore
SEQ-6508 Multiple objects or automation nodes from a multiple selection can be deselected again via Ctrl key + lasso
selection. To add multiple elements to a multiple selection use Shift key + lasso.
SEQ-6895 Option for adapting samplerate when copying and pasting tracks from a project with a different sample rate
SEQ-6284 Restrict fade-in length to maximum fade-out end position for symmetrical crossfades
SEQ-6821 New vertical zoom command "Zoom to selected track(s)"
Better object volume handling

SEQ-7014 Mouse pointer is hidden while vertical dragging for easier adjustment of objects near upper screen edge
SEQ-7260 Change volume by mouse dragging the numerical volume display in object footer
SEQ-7247 Object volume now changes in 0.1 dB steps (0.01 dB with Shift pressed) independent from track height
SEQ-7291 For coarse object volume adjustment use Ctrl key + dragging

Reworked Crossfade Editor
New window with controls and waveform
Direct fade and object editing via integrated arranger view
Remembers its position
Old behavior still available with [Factors] OldSemiModalSequoiaCrossfadeEditor=1
[SEQ-8298] Keyboard shortcut K for "Keep fade" didn't work
[SEQ-8298] New Keyboard shortcut Shift+K to access menu for setting in and out point
[SEQ-8023] Skin is switched with arranger skin + optimized colors



Mixer / Track Editor / Object Editor
Dockable Mixer

vertical scroller is available
sections collapse automatic when mixer is been docked
improved automatic resizing
buttons on the left side for section visibility

[SEQ-7073] , when increasing sizeMixer can have longer faders
Copy all plug-in-slots via drag'n'drop of plug-in button
SEQ-6962 "No effect"  menu entry renamed to "Remove plug-in"
[SEQ-8049] Smaller edit steps with mousewheel and arrow keys when using Ctrl+Shift keys together (especially using 0.01
dB  for volume / gain)
[SEQ-8252] Apply track timeshift to multiple selected tracks
[SEQ-7877] [SEQ-7741] Reset EQ commands now fully remove the EQ116 instances
[SEQ-6957] AUX Sends are now created without initialization to -89 dB

Active sends with level -inf / off are still marked active now
Send level for new AUX buses can now be adjusted directly after first mouse click, no need to set the level with a
2nd click any more

[SEQ-5663] Object editor AUX bus creation is now also possible with bypass switch (+ some fixes)
[SEQ-7353] + [SEQ-7657] Mixer: With Sends on fader, the color of a faders shows, whether the send is pre-fader,
post-fader, or direct-out

This can now be set on the fader via context menu as well (including multiple selection)
SEQ-6724 Show track color in new carbon track editor (vertical)
SEQ-5633 Show hand grab cursor with a plus when copying plugins
SEQ-6724 Track move line in mixer was sometimes not erased correctly - fixed
SEQ-6539 Missing apply to all menu button in object editor max / midi - fixed
SEQ-5833 Track Editor: EQ + Aux dropdown menus
SEQ-6375 Track Editor accessibility setting (for similar handling as in mixer)
SEQ-6809 Possible display problem with input section in older mixer skins - fixed
Bugfixes

[SEQ-8109] Change from 'VCA' to 'AUX' button labeling wasn't reverted after switching off sends on fader
[SEQ-8253] Track output field in mixer were shown partly black when the track had no color and were routed to
more than one buses

Effects / Routing
New and optimized support for external hardware effects

New entry "external FX" available in the plug-in browser for adding a new instance to an effect slot
Latency detection
Mono handling
Input, output and gain
Multiple instances on one track possible
only available with Hybrid Engine

New stereo enhancer algorithm which doesn't increase the gain of the mono signal (new default mode for new projects)
old projects are not affected
[SEQ-7927] Unified default stereo enhancer algorithm for objects and new AUX sends with new tracks

Dockable Plug-in-Browser
New dockable plug-in browser can be added via the '+' button in the docking manager
adds the plug-in to the last selected object or track (via 'Add' button or pressing Enter)

multiselection (tracks & objects) is considered
drag & drop of plug-ins from the search result list on track head, track editor, mixer, objects,   or VSTirouting widget
manager

ARA / Plug-ins
[SEQ-6904] ARA plug-ins can now be inserted as track effects

Plug-in instances are automatically inserted into all track objects, also when new objects are added (e.g.
after drag'n'drop or loading of audio to this track)

More supported ARA2 plug-ins:
SEQ-7152 Acoustica
SEQ-7246 Syncro Arts Repitch
[SEQ-7971] ARA support for ASAP Spectral Surface and ASAP Pitches Brew Plug-in

[SEQ-8208] SpectraLayers has a docking window like Melodyne
[SEQ-8203] Support for drag&drop files from VST plug-ins to the host project

e.g. for SpectraLayers
[SEQ-7863] Allow processing for shortcuts in VST plug-in windows, if shortcut is marked as "global"
DynamicEQ updated to 1.0.45

Oversampling as a per-preset parameter added
No processing of disabled EQ bands
Problems in user preset implementation - fixed

SEQ-5603 Softube Console 1 Support



Automation
Improved thin out function of automation points
An automation lane is able to have a range for editing the automation data (available via click on automation lane when a
range is active on the track)
[SEQ-6712] Deletion of ranges of track automation optimized: No automation points are created at selection borders if a
curve is flat in that range
[SEQ-7299] Prevent automation ramp from project start when creating an automation point via double click and then
dragging it
[SEQ-8039] Drawing on objects with volume automation mouse mode automatically activates volume curve for objects
(similar to track automation behavior)
[SEQ-7958] "Delete all curves" now works for multiple selected tracks
SEQ-5801 Update between Track Editor automation fader and automation lanes

Update between Stereo Editor dialog and automation fader
SEQ-6870 Improvements in consistency with Hide / Show automation lanes

"Show lanes for all curves" command now always creates new lanes if not existing
Prevent lane creation when switching active curve
Track automation mode - Handling of pan or volume lane creation using trackhead buttons
Automation lane "minus" button could keep its checked state even after removing lane - fixed

SEQ-6579 Commands for moving objects via menu/shortcuts (Ctrl+alt+shift+arrows) also move selected automation points,
depending on last selection
SEQ-7202 Zoom tool didn't work in automation lanes - fixed

Import / Export
Overworked export and track bouncing dialog

New naming template options
New preset handling
Integrated marker split options
New example text shows a preview for the exported filename
Quick info texts show overview over current settings of collapsed sections
User export presets

are loaded from and stored under "[ProgramData]/fx-presets/ExportPresets"
(old location was "[ProgramData]/fx-presets")
old export presets can be manually copied into that folder and should be listed when opening the
export dialog 

can be drag'n'dropped from file browser to preset list
context menu for presets via right-click

"Update with current settings" option
Changed menu structure for export functions

renamed menu command to "Export..."
export presets are listed below this command and replace old export commands
default Ctrl+E or other shortcuts for WAV or surround export are automatically remapped to new export
other functions are sorted in "Export MIDI", "Export Video" or "Extended Export" submenus
old "Save in format" for WAV projects also replaced by new export dialog

Keyboard shortcuts can be assigned to export presets in main menu
Last used preset available in dialog and main menu
Meta data editor (ID3) can be called from AAC format options
[SEQ-7479] + [SEQ-7480] Multi-format export

 Multiple audio formats can now be exported simultaneously
 In the  dialog, there is now a list of available export formatsExport

It is possible to select multiple formats via the corresponding checkboxes
[SEQ-7879] For quickly selecting a single export format, double-click the corresponding checkbox
Format-specific settings are located next to the format list

To select which format setting is currently edited, click the corresponding format name
[SEQ-7482] New  optionUse current project sample rate

If checked, this will always prevent resampling
Useful when working with export presets and the  commandExport with previous settings

[SEQ-7890] Check sample rate compatibility for each selected codec before starting
[SEQ-7751] ISRC and [SEQ-8059] CD / MP3 properties in export dialog naming template editor added
[SEQ-7891] Change the unit of the export length directly in the export dialog
[SEQ-8112] New option 'Move to recycle bin when overwriting' - When a new export overwrites existing files, these
are deleted to the recycle bin for a possible restore.
[SEQ-8085] Button text "Browse..." replaced with folder icon
[SEQ-7498] Select ten most recent custom folders from list
[SEQ-8187] Resampling quality button is deactivated if no sample rate change is active
[SEQ-8196] When activating an file format, the corresponding format settings are now shown automatically
[SEQ-8097] New option to consolidate bordering objects: Glue selected objects until silence 
[SEQ-8188] Renamed default export file naming template to "Project Name"
only for new installations or if a user deletes all naming templates
SEQ-7028 'Export to: Choose folder later' remembers selection during current session
SEQ-6816 Skip hybrid engine latency for realtime bouncing / mix to file
Bugfixes

[SEQ-8220] Pressing the 'x' button in the 'Overwrite existing files?' query dialog didn't cancel exports 
[SEQ-8219] Multitrack Export: Wrong file naming with option 'Choose Name later'

New "Export list" dialog - replaces and extends old multi job export
[SEQ-7600] Can be opened via



Main menu: "File" > "Export list..."
"Export" dialog: New "Open export list..." button

EDL import/export
[SEQ-8024] CMX-EDL-Export: extended compatibility with Premiere Pro, DaVinci Resolve, Media Composer and
Pyramix
[SEQ-8096] Export for Sequoia EDL, CMX3600 EDL, and compatibility EDL combined in one dialog and menu
command

[SEQ-7929] Project Files Dialog includes files referenced in revolver tracks
Project files dialog will open automatically if referenced files are not found

[SEQ-6819] Load files only to clipstore now also uses copy options (e.g. copy file to project folder)
Batch processing

[SEQ-7374] New resampling quality options for SoX algorithm
Waveform display in File Browser

Play start/stop with middle mouse button
DDP Export is directly available in main menunow 

Docking
[SEQ-6793] Window order in Docker and menu now synchronized with main View menu
[SEQ-6101] Change wording from "Monitoring" to "Monitoring section" in the + menu of the docker

Hardware Controller / Eucon
[SEQ-8110] Assign macros to Eucon hardware controller buttons
[SEQ-7420] Suppress error message during startup if EuCon is not installed and EuCon option was set
SEQ-3929 Extended PreSonus Faderport support for Faderport (v2), Faderport 8 and Faderport 16, see separate document
"PreSonus FaderPort Support EN.pdf" in program folder.
SEQ-7244 Improved coexistence of Faderport or other MIDI controllers with EuCon
Master's stereo enhancer jumps when activating MONO in any channel strip - fixed

MIDI
MIDI-Plug-ins

Support for MIDI VST plug-ins
New option im Plugin-Browser for adding a plug-in as a MIDI plug-in (dropdown option at 'Add' button)
MIDI Plug-ins are routed before VSTi und audio effects
SEQ-7351 Plug-ins inserted as MIDI plug-ins remember this when inserted again from "recently used" plug-in
browser tab or menu

They can also be added as MIDI plug-in to Favorites from there
only available with Hybrid Engine

MIDI Sender / Receiver
Effects only receive MIDI if "Receive MIDI" is activated in plug-in menu of the effect

is set automatically for VSTi and MIDI plug-ins (not changeable)
is set automatically for projects created with previous versions

"VST MIDI Out" has been renamed to "Send MIDI"
instead of the track option "VST MIDI Recording" a MIDI send plug-in can be chosen directly
caution: this is not compatible with old projects. Send plug-in still needs to be chosen manually
MIDI-In button in track editor is highlighted in case of receiving MIDI from a MIDI sender plug-in

Known issues
Currently only routing to VSTi is supported, no external MIDI devices
Bouncing doesn't consider MIDI-through state, sender plugins are always processed
MIDI sends from VST FX are delayed by one buffer while bouncing, while MIDI sends from other VSTi or
MIDI plug-ins not

only available with Hybrid Engine
MIDI Editor

Moving view with dragging middle mouse button. New option in mouse wheel settings.
Grid snapping for CC-Events. Available via holding ALT key if grid snapping is active.
Highlight current Object per default active

Automatic MIDI recording/arming for selected MIDI tracks now works for multiple selected tracks
Missing menu entries added to main menu

CC events displaying optimization grid lines are drawn in background
MIDI Object Editor: new checkbox "keep musical position..."

This allows single MIDI objects to keep sample position when the tempo map changes (useful for film sound
design/foley using MIDI events)

Warning when deleting a VSTi
Default activation of MIDI pre-recording and note-on chasing
MIDI input device default to "All"
[SEQ-3435] Tempo maps are now considered by looped MIDI objects
[SEQ-7382] Copying/pasting MIDI with active tempo map works now correctly
[SEQ-5429] MIDI arranger notes coloring improved for better contrast with different background colors.
[SEQ-6615] The pitch range of a MIDI object displayed in the project window is now only the range actually used by the
contained notes.

This behavior can be turned off under View options > Vertical MIDI auto zoom
[SEQ-7452] Quantize settings dialog (Toolbar and MIDI editor): Enable "End Q" to quantize note ends
[SEQ-7484] MIDI objects in project window: Notes of muted objects are colored grey like with single muted notes
[SEQ-7501] Support for Harmonica and 7 more Music Maker shop instruments
[SEQ-4500] Performance Issues with Vita Organ - fixed (download new version 2.6)
[SEQ-7609] Extendeded soft split for MIDI (  activated by ini entry [Factors]experimental,
SplitNotesWhenSplittingMidiObject=1)

If soft split is enabled, MIDI notes on object edges are splitted when MIDI objects are splitted
Onscreen MIDI Keyboard 

height can now be changed
[SEQ-8122] added scrolling with mouse wheel and zooming with ctrl + mouse wheel



MIDI Editor
SEQ-6576 MIDI Editor tooltips of CC-events
SEQ-6617 MIDI editor glue and split functions work now for all selected events
SEQ-6617 MIDI editor glue and split functions didn't consider object assignment when editing multiple objects -
fixed
SEQ-6491 Restrict velocity drawing to selected events if selected

SEQ-6716 Convert Yamaha note-offs for VST plugins
SEQ-6885 Support for VST3 LegacyMIDICCOutEvent
SEQ-6894 Adding VSTi to VSTi Manager via plugin browser didn't work - fixed

Accessibility
SEQ-6375 Track Editor accessibility 

Controls grouped in sections (similar to Object editor)
Sections can be switched with (Shift +) F6

SEQ-7104 Backwards cycle through Docker tabs with Shift + Ctrl  + Tab
New focus handling for Docker tabs

Shortcut for a window switch to this window if not active
Active windows are closed with shortcut

SEQ-7054 improve shortcut display for keys on the numeric pad with NumLock off
More

[SEQ-7475] Accelerated mouse handling for link curves to objects
[SEQ-6168] Accelerated switching of revolver tracks
[SEQ-7872] Vertical scrolling by mouse wheel dependent on project zoom
[SEQ-7895] Reduced memory usage of EQ116, especially when used in a lot of object instances
[SEQ-7867] Video, folder, tempo and surround tracks/busses aren't listed in the menu for track output recording any more
[SEQ-7874] WMA export removed
[SEQ-6169] Revolver track revision numbers synced for multiple selection: now all tracks get the same revision, so internal
revision don't has to be displayed anymore
[SEQ-7937] Track manager: change track color with single click instead of double click
[SEQ-7957] GUI_NoFocusHandlingWithMixerShortCut.INZ added for disabling new focus handling (introduced with build 22

)554
[SEQ-7897] "Client/Label" and "Working order" fields in CD burn-dialog TOC are empty in new projects
[SEQ-7912] Warning when disabling options that are neeeded for warping + tooltips when hovering over a warp marker with
deactivated warping
[SEQ-7541] Rename "Zoom to selected track(s)" command in some languages (DE)
[SEQ-7536] Adjust some wording and positions in view options
[SEQ-7603] Toggle Loop mode now has the default short cut [Shift] + [L]
[SEQ-7830] Color button in object editor now changes the object background color
[SEQ-7828] Use color / palette menu in track manager and object editor
[SEQ-7163] Folder picker uses new Windows UI
[SEQ-7677] Some localization changes for creating stereo objects from mono objects
SEQ-6839 Update Canis & Carbon Skin for Automation Panel and several Skin Fixes
SEQ-6853 Visibility of status bar is now saved in workspace (xml)
SEQ-6859 New font in Panner and optimized symbols
recalculating graphics now is done in background
Wide play cursor can now be enabled for all skins in view options (default off)
SEQ-6706 : automatic Sound Forge Pro 16 detectionExternal Tools
SEQ-7148 Peakmeters for monitoring section and external effects improved: Reset peak max and clipping LED via click
SEQ-7231 Options for ASIO dropout display/markers in extended recording settings
SEQ-6763 Workspace menu now includes options for editing and saving workspaces that were only available via right click
before



Bugfixes
[SEQ-8038] Marker reference to object on track one: after moving that track one to another position, the marker reference
stayed on track one instead on that object
[SEQ-8215] Possible crash with Blackmagic video card
[SEQ-5839] "Link left" object modes did not reset on second mouse click
[SEQ-7175] For "link left" object modes, ripple of markers moved markers to wrong position
[SEQ-8185] [SEQ-8210] Crashes and drawing issues when using option "Use destination mixer for source projects"
Shared mixer for source/destination - video track is now ignored for matching tracks
Spectral Cleaning multitrack editing

[SEQ-8125] Track selection didn't work in some cases
[SEQ-3878] Track selection box with more than 99 tracks was broken
[SEQ-3878] Menu break in track selection box for better handling
more fixes see below

Hardware controller
[SEQ-8226] Opening mixer did reset controllers assigned by MIDI learn function
[SEQ-8141] Help button or F1 opened wrong or no help window

[SEQ-8236] Take lane editing problems after inserting or re-ordering tracks while take lanes were open
[SEQ-8216] Multichannel files could not be loaded multiple times
[SEQ-8211] Re-linking virtual stereo files did not work
[SEQ-8244] Distorted audio when using surround AUXes without own pan setting
[SEQ-8181] Wrong display of object handles with active object footer and disabled 'Volume handles on top' option
[SEQ-8189] Export to 24Bit Wave - CD markers could disappear from wave project
[SEQ-8249] Crossfade settings: Default absolute zoom width could not be set below 500 ms
[SEQ-8235] Object resampling could still be marked as active after reverting project sample rate change
[SEQ-8028] Link curves to objects didn't work for submix folders
Plug-ins / FX

[SEQ-8169] ARA crash fix: Some plug-Ins do not support multiple projects at the same time
[SEQ-8234] When copying multiple tracks with VSTi to another project, only the first VSTi was transferred
External FX

[SEQ-8269] Warning when inserted / opened without hybrid engine
[SEQ-8259] Crash when closing project or program with open external FX dialog
[SEQ-7854] External FX dialog window caption now correctly displays 'External effect' instead of 'External
FX'
[SEQ-7854] 'External effect' dialog caption didn't show track and slot number like in other plugin dialogs
[SEQ-8043] The 'External effect' dialog was not hidden on project change although the option to keep it
open was disabled.

[SEQ-8135] Audio gaps when importing CDs with resampling
[SEQ-8145] AIFF Reader updated, some 24Bit AIFF files were not imported correctly
[SEQ-7336] Improved MIDI editor drawing performance
[SEQ-8123] AAF Export: possible crashes with option 'Convert stereo objects' fixed
[SEQ-8079] Stereo objects from mono objects: Wrong channel assignment with interleaved wave files fixed
[SEQ-8079] Stereo objects from mono objects: Stereo objects get time stamps from mono files
[SEQ-8165] *Loudness Adjustment* dialog: Small error in DE localization fixed
[SEQ-7631] File names for recording taken from track names were wrong on first project save
[SEQ-7472] Export dialog is shown on main screen when last position is unavailable (2nd monitor).
Mixer

[SEQ-8126] Wrong surround peakmeter display after mixer resize
[SEQ-8204] Missing mouse-over reset after right click on automation button in mixer
[SEQ-8176] Wrong mixer fader scaling when mixer size was reduced
[SEQ-7939] Keep mixer height when changing projects

[SEQ-8180] The track color setting for tracks with recording in progress was not used
[SEQ-8144] Unintentional multi-selection of markers after using CD index manager
[SEQ-8144] Issues while moving markers beyond other markers
[SEQ-8042] Save complete VIP: Correct handling of files with equal file names in different sub folders of the project folder
when "Keep project sub folders" was disabled.
[SEQ-5124] Issues with project names starting or ending with spaces - these are stripped now
[SEQ-8231] Multiselection for controls in arranger (e.g. monitoring) didn't work correctly 
Monitoring

[SEQ-8212] Correct handling of a bus named "Master" in addition to the stereo master in monitoring section
[  Some monitoring section texts were wrongly formattedSEQ-8154]

[SEQ-8155] [SEQ-6417] Time display: Performance improvements and bug fixes
Spectral Cleaning  

[SEQ-8119] Restore modal state after opening system settings to prevent crashes
[SEQ-8036] Window position on secondary screen wasn't restored
[SEQ-8118] Cursor jumped to view start after editing

[SEQ-7903] Non-functional "Export to Video Pro X" command removed
[SEQ-7805] Load / initialize warp markers correctly for objects with missing audio files
[SEQ-7667] Maximized state of floating docking windows were not restored after reopening the program
[SEQ-6643] Discarding a recent recording is not possible when the object was edited while recording (in according mode
"Playback & editing independent of recording"), the option to discard the recording is skipped in this case now.
[SEQ-5099] Objects could be pasted into tempo tracks
[SEQ-7948] Recording punch-in after entering a loop created unintended objects
[SEQ-7995] Playback jumped when soloing/muting an object with warp markers and the object editor was visible
[SEQ-7976] Playback with 'Continuous playback while editing' playback mode jumped when loop mode was on and the play
cursor was set before the loop start



[SEQ-8022] Display issues with minimum / maximum automation values
[SEQ-7646] Refresh track output routing in mixer was missing when routing fallback to default device was used after
deleting tracks
[SEQ-7896] External tools dialog: missing localizations (ES, FR)
[SEQ-7747] Track AUX send automation could use wrong values after stopping playback
[SEQ-7970] Mixer fader remained blue after changing track type back from submix to normal track
[SEQ-8025] Track naming refresh was missing for External Effects and Plugins after Undo
[SEQ-7538] Waveform graphic glitches when Pre-recording option was active
[SEQ-8001] Double click between 2 markers in the marker track created a range for the first track only
[SEQ-8076] 'Building Graphic' hanged after loading interleaved wave via file manager
[SEQ-6547] Menu command / shortcut for track phase invert didn't work for multiple selected tracks and neither respected
the "only invert left channel" setting
[SEQ-7956] Buttons for volume / pan curve activation didn't work for multiple selected tracks
[SEQ-8078] Using the command "Remove unused curves" on tracks without automation crashed the program
[SEQ-8016] Loop length changes of looped MIDI objects in object editor were not drawn
[SEQ-7925] Wrong menu break in context menus might result in invisible entries
[SEQ-8072] Object editor changes for different objects were collected in one undo step
[SEQ-7853] Prevent ripple with "Link markers to objects" if markers are locked
[SEQ-7777]  [SEQ-7983] Several fixes and improved performance for cursor drawing
[SEQ-8011] External tools dialog: several fixes
[SEQ-8086] Timestretching / Pitch shifting: several fixes
[SEQ-7892] Help browser was sometimes opened twice when using F1 and some help topics were missing
[SEQ-7892] Removed obsolete "Help Index..." main menu entry
[SEQ-8037] Wrong drawing of MIDI notes after soft split
[SEQ-7937] Track manager: issues with color menu handling
[SEQ-7940] Multi Track Export: ensure each track gets its own filename
[SEQ-7505] Some fixes for writing automation
[SEQ-8073] Missing marker redraw for "Link markers to objects" after using menu commands or shortcuts
[SEQ-3432] Track comments were not copied with tracks
[SEQ-8058] Track latency shift was not copied with tracks
[SEQ-8102] Issues with Zoom to selected tracks when all tracks are visible
[SEQ-8111] Crash when adding multiple hardware controllers
[SEQ-8115] [SEQ-8116] Several issues with mixer, crossfade editor and arranger drawing when forcing application defined
DPI scaling
[SEQ-8124] VST3: no output for some plug-ins (e.g. Acon Digital Remix)
[SEQ-8301] Possible missing break in side chain menu, if folders were present
[SEQ-8264] Incorrect position when loading resampled multi channel file into a new folder
[SEQ-8208] Fixed background color for Melodyne/SpectraLayers docking window
[SEQ-6420] Monitoring section plugin menu didn't work with "FX always on top"
[SEQ-7937] Track manager: drag'n'drop didn't work correctly anymore (Build 23115 only)
[SEQ-6611] wrong position of edit fields in managers
[SEQ-7295] gnudb cd online search didn't work anymore
[SEQ-7669] gnudb cd info: unicode problems with some special letters
[SEQ-5398] keyboard input was partly absorbed by host in edit controls of vst plug-ins (e.g. Melda plug-ins)
[SEQ-7446] Wrong wording for "Reset Quantization" in some languages
[SEQ-7964] Disable vertical scrolling for wave projects
[SEQ-8035] Track manager list import for didn't work for more than 99 tracks
[SEQ-8013] Shortcut list export would not work if  directory did not exist (e.g. after switching to anotherProject Files
language)
[SEQ-5849] missing drawing of object automation for max values
[SEQ-8026] Export dialog: incorrect format extension for example file name
[SEQ-4349] Fixed graphical issues that occurred after resizing the soundpool manager to minimal height
[SEQ-8045] Marker track: markers outside visible area still could be grabbed after zooming or scrolling operations
[SEQ-8056] Problems with setting project position to project start by click in left timeline border, now the gap between
marker/grid buttons and timeline is increased
[SEQ-5408] Issues with damping fader of Denoiser
[SEQ-7986] MIDI editor: some cursors were incorrect for the scrollers
[SEQ-8004] Unwanted minimizing of other tracks when "Maximize tracks automatically" is on
[SEQ-7845] Optimized text colors in managers
Record dialog: 'Resampling to 44.1 kHz' can't be activated
[SEQ-6965] Redrawing issues for track visualization and monitoring (track fx engine)
[SEQ-7954] ARA support for Auto Align 2 plug-in

 Missing undo step creation for routing tracks to submix bus[SEQ-7973]
[SEQ-7882] Occasionally missing display of play cursor in wave projects
[SEQ-7952] Take markers in projects could overwrite existing punch markers
[SEQ-7900] Takes changed their lanes unexpectedly when changing object borders
[SEQ-5774] Noise garbage with room simulator when resampling impulse responses
[SEQ-7928] Save as... for projects could provoke a crash if multiple revolver tracks were included
[SEQ-7922] Take lane issues with freeze/glue
[SEQ-7946] Old takes were shown with imported files or other new objects
[SEQ-7905] Missing take lane updates (e.g. after take manager operations, duplicate objects,...)
[SEQ-7930] After manually copying a project, sometimes audio files couldn't be found when switching revolver tracks
[SEQ-7771] Changes in monitor section could trigger warning for projects created in old version
[SEQ-7960] Shortcuts didn't work while hovering over buttons in arranger and mixer
[SEQ-7963] Possible crash when creating a new project after drag & drop of tracks
[SEQ-7667] Maximized state of floating docking windows was lost after minimizing and restoring the main window
[SEQ-7993] Drawing of automation data over maximum in the first automation lane could produce jump to minimum value



[SEQ-7877] Missing update of track routing dialog after loading a track FX preset
[SEQ-7932] Optimized contrast for arranger beat and sub-beat grid lines
[SEQ-6890] Missing restart of timestretching / pitch shifting after mute / solo in economy engine and also after moving object
while playback
[SEQ-6421] Avoid matching colors between take lanes and automation lanes
[SEQ-7659] Broken object automation mouse editing inside a range and at the end of an object - some remaining issues for
resampled objects fixed
[SEQ-7934] Issues after undo
[SEQ-7918] [SEQ-7919] Wrong text in ES language version
[SEQ-7831] Wrong automation panel width after project loading
[SEQ-7902] After performing Audio to MIDI Melodyne plug-in was still referenced in audio object
[SEQ-7923] Deactivated object automations were still active
[SEQ-7870] Icons in dockable plug-in browser were mixed up
[SEQ-7913] Output were muted when the skin in a wave project was changed
[SEQ-7805] Load warp markers correctly when loading projects that contain objects with missing audio content
[SEQ-7953] Crash in accessibility mode when showing the generic VST GUI for a plugin that has less than 8 parameters
[SEQ-7950] Problems with tempo adaption of objects when changing the project tempo
[SEQ-7744] The small red focus triangle was not displayed in the track info (track header) if the track was dragged very
small. It wasn't always visible on folder tracks either
[SEQ-7825] Dialog 'Marker with Name and Number' showed checkbox for audio markers when not recording
[SEQ-7800] System option "Create fades for new objects..." had started the VocAlign PlugIn - fixed
[SEQ-7245] If ranges were selected, new tracks were inserted in unexpected places
[SEQ-7785] There are plugins that produce stuck notes when the noteoff comes in the form of a noteon with velocity 0. This
is now converted to NoteOff.
[SEQ-7778] MUS file decoding might produce some artifact samples initially
[SEQ-7849] Borders for lanes were missing
[SEQ-7621] When generating file names from track names not all invalid characters are filtered out
[SEQ-7850] Pasting copied tracks overwrites track color and resets aux sends / plug-ins even when the respective options
were not selected
[SEQ-7822] Missing or wrong shortcuts in object context menu
[SEQ-7566] Missing refresh of track record buttons after loading or inserting tracks
[SEQ-6862] Avoid crashes with track FX monitoring by restricting economy engine to 16 threads by restricting maximum
thread number
[SEQ-7700] Export Dialog - Preset Handling: AAC and WMA codec settings were not restored
[SEQ-7793] Export Dialog - Multi-format export: several fixes
[SEQ-7297] External FX presets did not show their name when loading a VIP using it.
[SEQ-7359] Adding a tempo grid position marker during playback in tempo map grid mode added an inactive marker
[SEQ-7610] Converting Flac to Wave was very slow
[SEQ-7512] After manually copying the project, unfreeze could not find audio files in some cases
[SEQ-7265] Link status was not saved in mixer snap shots
[SEQ-7363] Broken linked channel offset in Sends on fader mode
[SEQ-7823] Crash with trim object
[SEQ-7623] Dialog for setting file name (choose file name later) in export dialog did not allow periods (.)
[SEQ-7694] Show surround master output devices in mixer (again)
[SEQ-7871] Export of tracks with VSTi output, also considering tracks that send MIDI to these VSTis.
[SEQ-7479] Fixed 384 kHz MP3 export when exporting in multiple formats
[SEQ-7914] Fixed several tooltip inconsistencies (VSTi slot in track editor, toolbar , ...)control for nudge object step size
[SEQ-7081] Docker window caption was offset
Automation

[SEQ-7355] Fix undo acceleration for object automation curves
[SEQ-7659] Broken object automation mouse editing inside a range and at the end of an object

Recording
[SEQ-7439] Punch In while playback - recorded object was longer than wave
[SEQ-7342] Record and playback devices had an unexpected reset after using "Record standard output"
[SEQ-7570] Unwanted cuts after recording

VST Plug-ins
[SEQ-4960] [SEQ-6629] Resizing issues with some VST3 plug-ins (iZotope Ozone, HOFA, FabFilter)
[SEQ-7601] VST3: no output for plug-in 'The God Particle'
[SEQ-5998] Checkbox "Scan user and system VST folders automatically for new plug-ins" is not initialized correctly
before the first VST scan of the session
[SEQ-7671] When copying certain VST3 plugins between objects in the object editor, the parameter settings were
not copied

 +  VST3: general compatibility fixes for window resize and side chain handling[SEQ-7696] [SEQ-7772]
[SEQ-7064] VST3: transmitting track color to plug-ins didn't work in some cases (wrong alpha value was used)
[SEQ-7899] Missing update of track name in VST3 plug-ins after moving them via drag'n'drop in mixer

[SEQ-7576] Wave editing with SoundForge could produce a peak at the end
Arranger

[SEQ-7624] Docking: Floating project windows are missing the window title update when changes are made
[SEQ-7433] Missing redraw of grid lines when scrolling vertically
[SEQ-7546] Video flicker in softscroll mode
[SEQ-7691] Objects were displayed shifted while scrolling horizontally
[SEQ-7487] Broken track head after undo called from menu or history

MIDI
[SEQ-7597] Crash in MIDI-Editor when using menu command "Split notes at playback cursor position"
[SEQ-7567] After double-clicking on a MIDI object, it sometimes took a long time for the MIDI editor to display the
content

[SEQ-5774] Noise garbage with room simulator when resampling impulse responses



[SEQ-7823] Crash with trim object
[SEQ-7870] Icons in dockable plug-in browser were mixed up
[SEQ-7566] Missing refresh of track record buttons after loading or inserting tracks
[SEQ-7785] There are plugins that produce stuck notes when the noteoff comes in the form of a noteon with velocity 0. This
is now converted to NoteOff.
[SEQ-7960] Shortcuts didn't work while hovering over buttons in arranger and mixer
[SEQ-6862] Avoid crashes with track FX monitoring by restricting economy engine to 16 threads by restricting maximum
thread number
[SEQ-7644] Performance problems with audio devices with more than 256 channels - fixed
[SEQ-7713] Missing translations for effect settings dialog in some languages - fixed
[SEQ-6166] Missing menu break for revolver tracks and some other menus - fixed
[SEQ-7822] Missing or wrong shortcuts in object context menu
[SEQ-7871] Export of tracks with VSTi output, was not considering tracks that send MIDI to these VSTis.
[SEQ-4960] [SEQ-6629] Resizing issues with some VST3 plug-ins (iZotope Ozone, HOFA, FabFilter)
[SEQ-7601] VST3: no output for plug-in 'The God Particle'

 +  VST3: general compatibility fixes for window resize and side chain handling[SEQ-7696] [SEQ-7772]
[SEQ-7064] VST3: transmitting track color to plug-ins didn't work in some cases (wrong alpha value was used)
[SEQ-7899] Missing update of track name in VST3 plug-ins after moving them via drag'n'drop in mixer
[SEQ-7577] Ctrl+Z shortcut for undo didn't work in Crossfade editor
[SEQ-7359] Adding a tempo grid position marker didn't snap to quantized position anymore
[SEQ-7952] Take markers in projects could overwrite existing punch markers
[SEQ-7800] System option "Create fades for new objects..." had started the VocAlign PlugIn - fixed
[SEQ-7297] External FX presets did not show their name when loading a VIP using it.
[SEQ-7659] Broken object automation mouse editing inside a range and at the end of an object
[SEQ-7691] Objects were displayed shifted while scrolling horizontally
SEQ-7509 Take menu was missing in object context menu - fixed
SEQ-7509 Take switching menu didn't work correctly in projects with many takes - fixed
SEQ-7460 Curve generator didn't work for selected lane - fixed
SEQ-7462 Some missing UI translations and text corrections - fixed
SEQ-6954 Roland Cloud VSTi crashes - fixed
SEQ-4589 Crashes with cut&paste in file manager - fixed
SEQ-7515 External FX: Latency detection affected other opened plug-ins - fixed
SEQ-7008 MIDI object editor

"Use musical tempo" was not transferred to other selected objects - fixed
Mute Controllers, Mute SysEx and other settings were not restored after loading a project - fixed

SEQ-7471 View Options: Waveform color setting 'group colors' did not work in versions other than DE - fixed
SEQ-7532 Continuous playback while editing: Playback restarted when range was changed with Shift+click - fixed
SEQ-6739 In some places a & character in marker or project names were displayed as underline - fixed
SEQ-7464 Casual crashes with custom toolbars - fixed
SEQ-7362 Closing hint dialog for new help dialog every time - fixedFaderPort controller with Cancel opened 
SEQ-7584 Flawed percussive transient detection - fixed
SEQ-7583 Wrong mixer track number after track exchange - fixed
SEQ-7572 AUX send coloring with AUX bus color didn't work anymore - fixed
SEQ-7574 Graphic error with mouse over at top of selected mixer track - fixed
SEQ-7466 VST3 Instruments with multiple outputs didn't work - fixed
SEQ-7568 Routing problems after moving multiple tracks at once - fixed
SEQ-7436 Multiple undo steps when adding busses - fixed
SEQ-7571 External tools didn't detect SOUND FORGE Pro Suite - fixed
SEQ-7595 Dysfunctional checkbox "Undo for plug-in settings" removed (did only work for DirectX plug-ins)
SEQ-7605 Surround mute/solo linking didn't work anymore - fixed
SEQ-7239 The '_FX.wav' files (results of offline FX processing) were placed in graphics folder (with
'AllHdpFilesInSubDirectory' .ini entry) - fixed
SEQ-7243 Wrong toolbar button states after loading workspaces or adding buttons - fixed
SEQ-6802 Cut tool for surround (folder) tracks didn't work - fixed
Canis skin: Range colors improved
SEQ-6419 Flickering when resizing docking windows reduced
SEQ-7254 Crash on right click at multiple selected object automation points - fixed
SEQ-7271 Issues with entering time in CD MSF format - e.g. when changing (start) pause time - fixed
SEQ-7271 Track delay display in ms or m was truncated to integer values - fixed
SEQ-6882 Effect option "Use mixer phase switch only on left channel" is now ignored on mono tracks
SEQ-7226 Several inconsistencies with EQ frequency automation - fixed
SEQ-7267 Mouse clicks into windows (e.g. for closing plug-in windows) could be end up in mixer window below it - fixed
SEQ-6518 Opening surround panner from AUX output section didn't use tabbed panning dialog - fixed
SEQ-7142 Wrong display of time differences for bars/beats in projects with applied tempo map - fixed

Range length + object length now displayed correctly
Editing works correctly now, including relative position changes (e.g. "+1,," for 1 bar or "+1," for one beat)

SEQ-7143 Wrong time display and snap handling with project snap offset and bars/beats snap - fixed
SEQ-7138 Crashes after multiple import of files with a "." dot and offline resampling - fixed
SEQ-7274 Deleting a range in automation lane caused following objects to move - fixed
SEQ-7303 Crashes with more than 32 MIDI input devices - fixed
SEQ-6950 Export with Preset menu commands didn't work with Wave projects - fixed
SEQ-7294 Crossfade Editor didn't remember it's size between sessions - fixed
SEQ-7273 Empty tracks displayed a non-zero peak level in track head peak meter- fixed
SEQ-7292 Floating mixer didn't adapt to the number of tracks in project when changing active project anymore - fixed
SEQ-7292 Floating mixer reduced to zero size without active project - fixed
SEQ-7256 Objects did vanish after resizing them to zero length - fixed (by restricting minimal length to 1 sample)
SEQ-7300 VCA faders were not updated while writing automation - fixed



Text character display problems in CD burner drive selection - fixed
SEQ-7290 Using Enter key instead of clicking OK button didn't work under some circumstances in hardware controller
dialog - fixed
SEQ-7309 Surround volume offset between channels (e.g. after adding a track or changing surround setup) - fixed
SEQ-7304 Several issues with moving tracks into folders (e.g. tracks were not hidden after moving them into a collapsed
folder track) - fixed
SEQ-7341 Playback problems in Take Composer - fixed
Canis Skin: Mixer setup button text was missing - fixed
SEQ-4481 Possible Crash when changing tempo automation - fixed
SEQ-7325 Problems with naming templates with track name and number for object export - fixed
SEQ-6924 + SEQ-7393 Problems with object handles for small objects (e.g.  lock handle) - fixed
SEQ-7427 Several skin fixes
SEQ-6909 Timestretch cursor was not displayed anymore at object end - fixed
SEQ-6306 Export: Problem with surround and Split at markers option - fixed (Split at markers disabled for surround)
SEQ-7159 Some problems with multiple punch-in recordings - fixed
SEQ-6110 text input for Softube plug-ins didn't work - fixed
Displaced calculation of object automation for timestretched or resampled objects (SEQ-6915)
AAF Export

Problems with compatibility option "Track + object automation" if no object automation was present (SEQ-6077)
No automation export for deactivated curves anymore (SEQ-6077) 

Crashes after moving automation lines (SEQ-6944)
Random peaks when opening spectroscope (SEQ-4660)
Exclusive solo couldn't be used with folder tracks (SEQ-5058)
Paste tracks: improved horizontal AUX alignment in mixer (SEQ-6880)
Accessibility setup: crashes in MIDI object editor with (Shift+)Tab (SEQ-6390)
VST instruments could not be added in VSTi Manager (SEQ-6894)
Rejecting MIDI recording deleted automation (SEQ-6912)
Problems with Plugin Browser filter settings (SEQ-6868)
Wrong track number display in VSTi Manager (SEQ-6548)
Crashes with tuner visualization (SEQ-6815)
Stereo master was not muted for surround master only export (SEQ-6660)
Keeping overview mode after closing CFE, but hiding it in CFE (SEQ-6945)
Wrong MIDI device display in start screen (SEQ-6900)
Overlapping text in pan/stereo editor (SEQ-6333)
Master Fader Link: Problems with offset for old templates - fixed
Crash while opening Audio Quantization - fixed
Disappearing mouse cursor in mixer - fixed
Wrong bar/beats display when using tempo map - fixed
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